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Preface

Mainframe Navigation allows you to access and manipulate objects stored on a mainframe from
a Windows application. These objects include datasets and files, members and elements, load
modules, as well as system objects such as active jobs or the console under the z/OS, z/VSE and
BS2000 operating systems. With Mainframe Navigation, the objects are displayed in a tree structure
and can be listed, browsed and edited with a Windows-like user interface. On the mainframe
server, Mainframe Navigation is supported by Natural ISPF.

This documentation is organized under the following headings:

Installation and Configuration =~ How to install and configure Mainframe Navigation. Prerequisites on
the mainframe server.

Starting and Terminating Entire How to start and terminate Entire Systems Management, which is the

Systems Management framework for managing Mainframe Navigation.

Elements of the Application General information on the Entire Systems Management application

Window window (for example, on the menu bar, object workspace, or content
pane).

Managing the Server Nodes Explains the operations that can be performed on a server node.

Listing and Filtering Objects How to list objects and how to reduce the number of shown objects.

Detailed information on how to list and filter a specific type of object
is provided in the appropriate section later in this documentation which
deals which this type of object.

General Commands for Managing How to edit, browse, copy, delete, rename and send objects. The

Different Types of Objects descriptions in this section apply to all types of objects. They are not
repeated in later sections of this documentation which deal with the
different types of objects.

Managing z/OS Objects How to manage z/OS datasets, PDS members, volumes, jobs, sysout
datasets and active jobs. How Natural ISPF objects are supported under
z/OS.

Managing z/VSE Objects How to manage z/VSE files, sublibraries, members, volumes, jobs and
active jobs.

Managing BS2000 Objects How to manage BS2000 files, elements, element versions, jobs and job
variables.

System Log How to browse the system log, which is available for each z/OS and
z/VSE node.

Console How to browse the console and issue operator commands to the console,

which is available for each z/OS, z/VSE and BS2000 node.

Vii
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://documenta-
tion.softwareag.com. The site requires credentials for Software AG's Product Support site Empower.
If you do not have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

Mainframe Navigation



http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com/

About this Documentation

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG TECHcommunity
website at http:/techcommunity.softwareag.com. You can:

" Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest.
" Access articles, code samples, demos, and tutorials.

= Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Mainframe Navigation 3
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Installation and Configuration

Server Prerequisites

The following Software AG products must be installed on the server:
® According to the desired type of communication between the Natural for Windows client with
the remote Natural mainframe server environment, one of the following must be installed:

* Natural Development Server (NDV) is required for working in a Natural Single Point of
Development (SPoD) environment, or

" EntireX Communicator (EXX)  is required for working in a Natural Remote Procedure Call
(RPC) environment.

® Natural ISPF (ISP) 8.2 or above.
" System Automation Tools (SAT).
® Entire System Server (NPR).

= Natural for Mainframes (NAT) ", including the Entire System Server Interface (ESX). See Installing
the Entire System Server Interface in the Installation documentation which is provided with Natural
for Mainframes.

"The required version of Natural Development Server or EntireX Communicator, and of System
Automation Tools and Entire System Server depends on the installed Natural version. See the
Release Notes which are provided with Natural for Mainframes.

" The required Natural version depends on the Natural ISPF version running on your system.

If using Natural Roll Server, the minimum roll slot size for Roll Server must be 300KB.

Installation on Windows

Mainframe Navigation can optionally be installed with Natural for Windows. It needs to be installed
with either the Natural development environment or the Natural runtime environment. If Main-
frame Navigation has not yet been installed, proceed as described below. For more information,
see the Natural for Windows installation documentation.

~ To install and configure Mainframe Navigation on your local machine

1  Start the Software AG Installer and specify all required information on the different panels.
2 When the product selection tree is shown, expand the Natural Products > Natural node.

3  Select Runtime Environment and/or Development Environment.

8 Mainframe Navigation



Installation and Configuration

If you want to work in a Natural Single Point of Development (SPoD) environment, make
sure that Development Environment is selected.

Instead of working with SPoD, you can also work in a Natural Remote Procedure Call (RPC)
environment using EntireX Communicator (EXX). Via the RPC communication, you can
combine Mainframe Navigation with Output Management GUI Client and Entire Operations
GUI Client.

4  Select Entire Systems Management. This installs Mainframe Navigation, Output Management
GUI Client and Entire Operations GUI Client.

5  Choose the Next button to continue with the installation.

Initializing Mainframe Navigation

Only required if you want to work in an RPC environment using EntireX Communicator. Not re-
quired for a SPoD environment.

When the Software AG Installer has finished the installation, you have to initialize Mainframe
Navigation. Only initialized clients will be shown in the Entire Systems Management application
window.

~ To initialize Mainframe Navigation

1 Choose All Programs > Software AG > Administration > ESM Configuration for Natural
n.n from the Windows Start menu.

where n. n stands for the current version number. The Start menu group name (by default,
this is "Software AG") can be changed during the installation.

2 In the resulting dialog box, open the drop-down list box next to Mainframe Navigation and
select initialize.

3  Choose the OK button.

Configuring the Connection to the RPC Server Environment

Only required if you want to work in an RPC environment using EntireX Communicator. Not re-
quired for a SPoD environment.

In order to configure the connection to your Entire Systems Management (ESM) RPC server envir-
onment, you have to change the parameter file SYSESM2 using the Natural Configuration Utility
(see the Natural for Windows documentation for detailed information on how to use this utility).

Mainframe Navigation 9



Installation and Configuration

This parameter file is available when an ESM product such as Mainframe Navigation has been
installed; it is only used for RPC.

In addition, you have to modify the configuration files services and hosts in your local file system.

~ To change the parameter file SYSESM2

N

N U1 B~ W

Start the Natural Configuration Utility.

In the tree on the left side of the Configuration Utility window, expand the node for the
parameter file SYSESM2.

Expand the node Client/Server.
Select the node Remote Procedure Call.
On the right of the window, select the RPC (Client) page.

Enter the name of your ESM RPC default server (DFS) in the Server name text box (this replaces
the default value "ESMSRV").

Enter the name of your communication broker node in the Server node text box (this replaces
the default value "BKR001").

Save the parameter file and exit the Natural Configuration Utility.

~ To modify the configuration files services and hosts

The configuration files services and hosts are typically located in the subdirectory system32\drivers\etc
of your Windows directory. It is recommended that you back up your configuration files before
you commence with the following steps.

1
2

Switch to your local machine.

Open the services configuration file in a text editor and insert the following line:

server-node port-number/tcp

where server-node is the host name of your communication broker node as defined in the
Configuration Utility (see above) and port-number is the port number to be used.

Note: The port number determines where the additional line must be inserted in the

services configuration file. For example, if an entry with the port number 2500 exists
and is followed by an entry with the port number 4000, you have to insert an additional
line between these entries for the port 3800.

To allow resolution of a symbolic network name of your broker node, this name must be re-
solved by your LAN name server or in your local hosts configuration file.

Open the hosts configuration file in a text editor and insert the following line:

10
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Installation and Configuration

ip-address server-node

where ip-address is the IP address of your communication broker node in your LAN and
server-node is the name of your broker node.

Installation on Mainframe Servers

There is no special installation required. Make sure that the products listed under Prerequisites
are installed on the mainframe server.

If you want to access multiple Entire System Servers with the same SYSESM2 parameter file, you
can use the dynamic parameter DFS to overwrite the settings in the parameter file, for example,
DFS=(ESM62SRV,BKRO62, L). For further information on the DFS parameter, see the Parameter Reference
in the Natural for Mainframes documentation.

Defining the Entire System Server Nodes

When all required products are installed on the mainframe server, you must define all Entire
System Server nodes you wish to access with Mainframe Navigation. This is done with Natural
ISPF. For detailed information, refer to the section System Configuration > Entire System Server Node
Table in the Natural ISPF Administration Guide.

Ensure that the Entire System Server node table has been edited (at least a minor modification)
and saved (command END). Example:

COMMAND ===

Node Description Name
__ 69 E-machine(Prod) MVS_ DAEE
148 F-machine(Dev.) MVS_ DAEF
248 A-machine(Demo) MVS_ DAEA

50013 Test MVS ESY5999 ENTI NOT ACTIVE
_ 194 0SD5 SI15 7.500-S115-2
_ 193 VSE X-machine VSE.ESA.SUPX
55521 Test VSE VSE.ESA.TEST

Ensure that the access to all nodes is active and works without any warnings (for example, ESY5...)
when saving the nodes table.

Mainframe Navigation 1
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Configuring Natural ISPF on the Mainframe Server

Make sure that Natural ISPF is configured correctly on your mainframe server:

® Ensure that the installed subsystems are defined in the configuration member CONFIG: your
site's operating systems, Natural and System Automation Tools (SAT).

For detailed information, refer to the section System Configuration > Editing the Configuration
Member CONFIG > Defining Installed Subsystems in the Natural ISPF Administration Guide.

® Ensure that the authorization table of the user who should use Mainframe Navigation has a
defined status (compare the Auth attribute in the Defined Characteristics column). This can be
done by defining the authorization table for the user explicitly, or it can be inherited from a
prefix definition, from a (Natural Security-based) user group definition or from the default user
definition (which is indicated by an asterisk (¥)).

For detailed information, refer to the section User Definitions in the Natural ISPF Administration
Guide.
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Starting Entire Systems Management in an RPC Environment

Output Management GUI Client, Entire Operations GUI Client and Mainframe Navigation are all
managed using Entire Systems Management.

Output Management GUI Client and Entire Operations GUI Client are always started in an RPC
environment.

Mainframe Navigation can be started in either an RPC environment (see below) or in a SPoD en-

vironment (see Starting Mainframe Navigation in a SPoD Environment).

~ To start Entire Systems Management in an RPC environment

1

From the Windows Start menu, choose All Programs > Software AG > Tools > Entire Systems

Management for Natural n.n.

| Note: The Start menu group name (by default, this is "Software AG") can be changed

during the installation.

The following dialog box appears.

Software AG ESM Application Login Screen

—Matural Security Login an Server

User I IN.&TLIH.&L

Passward: I

Change password

—Entirex Communicator Broker Security Authorization

[ Cifferent User ID for Ertire Broker Security

User |0 I.&DMINIST

Pazsword: I

—Default zerver
Mode name: BKREOS4: 3800 TCP

Server name:  MOP33SRY

Ok Cancel

| Note: With the user exit ESMAPTON (which is located on the client in the SYSSATGF library),

the administrator can change the appearance of the login dialog box. For example, the

16
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2

administrator may define that it is not possible to specify a different user ID, or that a
password is not required.

Specity the following information:

® Natural Security Login on Server
Your user ID is automatically provided. You can also log on using a different user ID.

Specify user ID and password in the corresponding text boxes.

If you want to change your Natural Security password, choose the Change password button.
In this case, the upper part of the dialog box changes, providing text boxes in which you
have to enter the old password, the new password, and a confirmation of the new password.

. Note: If your Natural Security password has expired, the dialog in which you have

to change the password is immediately shown.

* EntireX Communicator Broker Security Authorization
If you want to use a different user ID for EntireX Broker Security, activate the corresponding
check box.

Specity user ID and password in the corresponding text boxes.

Choose the OK button.

The Entire Systems Management window appears. See Elements of the Application Window
for further information.

Starting Mainframe Navigation in a SPoD Environment

If you want to start Mainframe Navigation in a Natural Single Point of Development (SPoD) en-
vironment, you have to do this from within Natural Studio.

~ To start Mainframe Navigation in a SPoD environment

1

From the Windows Start menu, choose All Programs > Software AG > Tools > Natural n.n.

Note: The Start menu group name (by default, this is "Software AG") can be changed

during the installation.

Natural Studio, the development environment for Natural, appears. Now you have to access
the mainframe environment in which the Entire System Server nodes have been defined.

From the Tools menu, choose Map > Environment.

Mainframe Navigation 17
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The Map Environment dialog box appears. Your user ID is automatically provided.

Map Environment |

— Server

Huost name: Il

Server port: I

E nviranment name: I

— Startup

Seszioh parameters: |

User ID: [NATURAL

Pazszword: I

k. I Cancel Help

3  Specify the following information:

Option Description
Host name The name of the development server.
Server port The TCP/IP port number of the development server.

Environment name |Optional. The name that is to appear in Natural Studio's library workspace.

Session parameters |If dynamic parameters are required for your development server, specify them
in this text box. Otherwise, leave this text box blank.

User ID If you want to map the development server using a different user ID, specify it
in this text box. This is useful, for example, when Natural Security is active on
the development server and administrator rights are to be used.

Password If Natural Security is active on the development server, specify the required
password in this text box. Otherwise, leave this text box blank.

4 Choose the OK button.

Once you have mapped a development server, a node for this development server session is
shown in the library workspace.

When the connection has been established, all libraries (according to the security profile) for
this session are shown in the library workspace. You are automatically logged on to your
default library.
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5  From the Tools menu, choose Development Tools > Mainframe Navigation.
Or:
Enter the Natural system command SYSMN in the command line.

The Entire Systems Management window appears. See Elements of the Application Window
for further information.

Terminating Entire Systems Management

Output Management GUI Client, Entire Operations GUI Client and Mainframe Navigation are
terminated when you close the Entire Systems Management window.

~ To close the Entire Systems Management window
= From the Object menu, choose Exit.
Or:

Choose the following toolbar button:

i

Or:

Press ALT+F4.

Or:

From the Control menu, choose Close.
Or:

Choose the corresponding standard button at the right of the title bar.

Mainframe Navigation 19



20



4

Elements of the Application Window

B GENETAl INfOMMALION ..o e e e
B BNIU Bl ..ot

= Toolbar

= Tracing

ODBJECE WOTKSPACE ...ttt
CONENE PANG ...
(07010 ) A1 (=T U PR
RESUIL VIBW ..
(070 04114 [0 [ X T PR
SHATUS Bl ...
DOCKADIE WINAOWS ...t et
Refreshing the DISPIAY ..........ooiiiiiiiii s

21



Elements of the Application Window

General Information

When you start Entire Systems Management, the following application window appears:

'_ErltirE Systems Management [ QAS2ROP4 : DAEF-4020 ]

Object View Options My Desktop Window Help
& e L el e G

-5y Output Management
(- Entire Operations
- i8¢ Mainframe Navigation

©,, User SAGTEST L@ Server. DABZROP4 |&| Mode: DAEF 4020 -

The Entire Systems Management application window may offer information for one or more of
the following applications:

® Output Management GUI Client

® Entire Operations GUI Client

® Mainframe Navigation

When an application is installed, the corresponding folder is shown in the application window.

If you are not authorized to use an application, the icon which is shown for this application contains
an X (meaning, this application is crossed out).

] Note: Output Management GUI Client and Entire Operations GUI Client can only be used

in an RPC environment. Mainframe Navigation can be used either in an RPC environment
or in a SPoD environment. When working in a SPoD environment, the folders for Output
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Management GUI Client and Entire Operations GUI Client are crossed out, which indicates
that you cannot work with them.

The application window contains the object workspace on the left and the content pane on the
right. To modify the size of such an area, move the mouse pointer over the border separating the
two areas until the pointer changes, showing two arrows pointing in opposite directions (+*).
Then drag the border using the mouse until the areas have the desired size.

More information on the elements of the application window is provided in the topics below.

Menu Bar

The following menus are available:

Menu

Description

Object

The commands in this menu change according to the object which is currently selected in the
object workspace. Some of these commands are also available in the context menu which appears
when you select an object in the object workspace.

This menu also contains commands for saving changes in an editor window, for closing the active
window in the content pane, for defining the page setup for printing, and for exiting Entire
Systems Management.

View

Using the commands in this menu, you can show or hide different elements of the application
window (for example, the object workspace or status bar).

Options

Using the commands in this menu, you can choose whether to use the English or German language.
You can define the refresh mode (see Refreshing the Display) and specify trace options (see
Tracing).

The following restriction applies for Mainframe Navigation: when you choose the German
language, only the menus and the menu commands are shown German; the Mainframe Navigation
dialog boxes and messages are always shown in English, regardless of the chosen language.

Window

Using the commands in this menu, you can activate the next or previous inactive window in the
content pane.

Or you can close all windows in the content pane. When the changes in a window have not yet
been saved, a dialog box appears, asking whether you want to save the changes.

A list of open windows is shown at the bottom of the menu. The window which is currently
active is indicated by a check mark. To activate another window, choose the corresponding entry
in the menu.

Help

Using the commands in this menu, you can invoke the online documentation or display
information about an application.

The current selection in the object workspace is important in this case. For example, when
Mainframe Navigation (or one of its nodes) is currently selected, you can invoke help for
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Menu Description

Mainframe Navigation or you can display, for example, the version number of the installed
version.

Note: The following menus can also be shown: the Edit menu which is shown when an ed-

itor window is active, and the Browse menu which is shown when a browse window is
active.

Toolbar

You can execute several functions using a toolbar button. When you move the mouse pointer over
a toolbar, a brief description for the button is shown in the status bar. In addition, tooltips appear
for the buttons.

The available toolbar buttons may differ depending on the current context. For example, there are
toolbar buttons which are only available when an editor is active. If a toolbar button is grayed-
out, the command is not available for the selected object.

Object Workspace

The object workspace on the left side of the application window contains a tree view. All objects
that can be managed with Entire Operations GUI Client, Output Management GUI Client and/or
Mainframe Navigation are available in the corresponding folders of the tree.

You can expand or collapse a folder in the tree by clicking the plus or minus sign in front of a
folder. A folder preceded by a minus sign has been fully expanded.

When using the keyboard, you can navigate in the tree using the following keys:

Key Description

UP-ARROW Move the selection up in the tree view.

DOWN-ARROW [Move the selection down in the tree view.

RIGHT-ARROW |Expand an object in the tree view.

LEFT-ARROW | Collapse an object in the tree view.

HOME Selects the first object within the tree view. This also works in a list view window.
END Selects the last object within the tree view. This also works in a list view window.
ENTER Corresponds to double-clicking an object. Collapses or expands an object, depending on its

current state. When an object cannot be expanded any further and when the Browse
command is available for this object, its content is shown in a browse window.
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~ To show or hide the object workspace

s From the View menu, choose Object Workspace.

When the object workspace is shown in the application window, a check mark is shown next
to this menu command.

Content Pane

The content pane is shown on the right side of the application window. When you invoke a com-
mand for an object, the corresponding list view window, editor window, diagram or dialog box
appears here.

Context Menus

Context menus provide for selection commands that are valid in the current context (that is, for
the item that is currently selected). The content of a context menu depends, for example, on the
object which is currently selected in the object workspace or which is active in the content pane.

Commands that are grayed-out are not available for the selected item.

> To invoke a context menu

1  Select the item for which you want to invoke a context menu (either in the object workspace
or in the content pane).

2 Click the right mouse button.
Or:
Press SHIFT+F10.

The context menu appears and you can now choose the required command.
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Result View

Only supported by Output Management GUI Client and Entire Operations GUI Client.

The result view is shown at the bottom of the application window. It contains hints, errors and
warnings which occur during the session.

x
= Time Sender I Shart Meszage Severity Iﬂ
Q,) 207 11-1012:50:02:2  Activate Metwork Metwork, Master SAGHET [SAGTEST] | Activated by User ID SAGTEST Infarmation
Q,) 207 11-1012:50:02:2  Activate Metwork Metwork, Master SAGHET [SAGTEST] | ... Start Time 1z 2017-11-1012:50 Infarmation
Q,) 2007-11-1012:580:022  Activate Network Network, Master SAGNET [SAGTEST] | EOR1042 - Metwork SAGNET activated, Run 322 |nformation
9 2M711-1017:0%:23:9 | Maintenance Job Master JOB-01 [EXAMPLE BEO-FLOW] | EOR2311 - Invalid Combination Job Type / JCL Location Emor
Q,) 2M711-1017:06:0571 | Maintenance Job Master JOB-01 [EXAMPLE BEO-FLOW] | EOR1130 - Job Definition madified |nformation
Q,) 2007-11-1017:06:05:1  Maintenance Job baster JOB-01 [EX&MPLE BEO-FLOW] | ... Yersion [unnamed) |nformation j
, NGC fj, OGC |

Using the context menu, you can display detailed information for a specific entry, or you can delete
the selected or all messages in the result view.

> To show or hide the result view

s From the View menu, choose Results.

When the result view is shown in the application window, a check mark is shown next to this
menu command.

Command Line

The command line is only supported by Output Management GUI Client and Entire Operations
GUI Client. See also the information on direct commands in the Output Management GUI Client
documentation and in the Entire Operations GUI Client documentation.

JJ Command: || j

Each command that you enter in the command line is saved for the current session. The drop-
down list box contains your last entries (history).

> To show or hide the command line

s From the View menu, choose Command Line.
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When the command line is shown in the application window, a check mark is shown next to
this menu command.

> To issue a command in the command line

3

Make sure that an item in the Entire Operations folder is currently selected.

Type the command in the text box of the Command drop-down list box.
Or:

When the mouse pointer is positioned on the Command drop-down list box, you can also
use the right mouse button to invoke a context menu. Using the commands from this context
menu, you can, for example, paste a text string into the command line.

Note: In addition to the standard Windows editing commands such as Cut and Paste,

the context menu may also contain Windows commands for Unicode. See your Windows
documentation for further information.

Press ENTER to execute the command.

~ To issue a command using the command line history

1

Open the Command drop-down list box and select an entry.
Or:

Enter the first character of a command that you have previously entered in the text box of the
Command drop-down list box. The corresponding command automatically appears in the
text box. When you have previously entered several commands which start with the same
letter(s), the command that has been entered last appears in the text box.

Press ENTER to execute the command once more.

Status Bar

The status bar is the horizontal information line at the bottom of the application window.

Onits left side, the status bar shows short help texts for the commands in the menu bar and context
menu. When data are currently received from the server, this information is also shown.

On its right side, the status bar shows the login user ID, the server name and the server node. For
Mainframe Navigation, this information is only shown when working in an RPC environment.
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> To show or hide the status bar

s From the View menu, choose Status Bar.

When the status bar is shown in the application window, a check mark is shown next to this
menu command.

Dockable Windows

The following elements of the application window are dockable windows:

" toolbar
" object workspace

" result view
Using the mouse, you can drag a dockable window to another position so that it is shown

" at another position within the application window, or

" in a window of its own.

You can move the window freely on your screen. You can move it back to the application window
(for example, back to its original position) so that it is no longer shown in a window. This process
is called “docking”.

> To undock/dock a window

= Double-click the two lines which are shown for the docked window. For example:

=
Or:
Double-click the title bar of an undocked window.

When the window is currently docked, it is undocked. When the window is currently un-
docked, it is docked at its previous position.

~ To drag a docked window to another position

1 Move the mouse pointer to the two lines which are shown for the docked window.

2 Press the mouse button and drag the window to another position.
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An outline of the window is shown. The outline indicates the position at which the window
can be docked.

If you want to prevent docking (that is, if you want to undock the window), press CTRL while
dragging the window.

Release the mouse button.

~ To drag an undocked window back to the application window

Move the mouse pointer to title bar of an undocked window.

Press the mouse button and drag the window to the position at which you want to dock it.

An outline of the window is shown. The outline indicates the position at which the window
can be docked.

Release the mouse button.

Note: The commands in the Windows menu do not apply to dockable windows.

Refreshing the Display

You can refresh the contents of a folder in the object workspace. Or you can refresh the content of
a list view window. The most current information from the server is then shown. The amount of
information that is refreshed depends on the refresh mode that has been defined.

~ To refresh the display

1

Select a folder or one of its subfolders in the object workspace.
Or:

Activate the list view window that is to be refreshed.

Press F5 to refresh the display.

~ To define the refresh mode for the object workspace

From the Options menu, choose Refresh Mode > mode, where mode is one of the following
commands:
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® Current Level
Refreshes only the folder which is currently selected in the tree.

® Recursive
Refreshes the folder which is currently selected in the tree and all of its subfolders.

| Note: Entire Operations GUI Client provides an Auto Refresh functionality for certain list
view windows. This can be defined in the user settings.

Tracing

In case of problems, you can enable tracing and thus write the trace information to a log file. Due
to performance issues, this should only be done when requested by Software AG support.

The log file is created in the directory which is defined by the environment variable % TEMP%. The
name of the log file depends on the trace option, see below.

~ To activate tracing

s From the Options menu, choose Trace > option, where option is one of the following com-
mands: Level 1 through Level 9.

The higher the trace level, the more information is written to the log file.

~ To deactivate tracing

= From the Options menu, choose Trace > No Trace.

~ To specify the destination file for the log information

= From the Options menu, choose Trace > option, where option is one of the following com-
mands:

® Overwrite
The content of the log file is always overwritten. The name of the log file is estrace.log.

® Continous
The content of the old log file is not overwritten. A new log file is created instead. The name
of the new log file is estrace_<date>_<time>.log, where date has the format yymmdd, and
t ime has the format hhmm:ss.
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Managing the Server Nodes

Displaying the Server Nodes

To manage the contents of a server node, you first have to expand an operating system node in
the object workspace. The following operating system nodes are available: 0S390 Nodes for z/OS,
VSE Nodes for z/VSE and OSD Nodes for BS2000.

The features which can be used depend on your ISPF profile and your security system on the
mainframe.

~ To display the server nodes

1  In the object workspace, expand the Mainframe Navigation folder.

The operating system nodes are then shown in the tree.

2 Expand an operating system node to display all defined and active server nodes.

Example:

Elﬂ hainframe Mavigation

[+ @ WSE NDdES
- 05D Modes

Logging on to a Server Node

Logging on to a server node is necessary if you want to change your user ID on the mainframe,
or if the automatic logon option for the node has been set to "NO" (see also Displaying the Prop-
erties of a Node).

~ To log on to a server node

1  In the object workspace, select the appropriate server node.

2 Invoke the context menu and choose Logon.
Or:

Press CTRL+ALT+L.

34 Mainframe Navigation



Managing the Server Nodes

The following dialog box appears:

148 Logon Node |
Entire System Server Logon
User ID: INATLIR.&L
Pazsword: ||
Ok Cancel

3  Enter the user ID that is required for logging on to the server node.
4  Enter the password.
5  Choose the OK button.

Duplicating a Server Node

Duplication creates a new logical view on the same physical node. It does not create a new node,
nor does it start a new Entire System Server node (this means, duplicating does not start or stop
anode on the Entire System Server level).

~ To duplicate a server node

1 Inthe object workspace, select the appropriate server node.

2 Invoke the context menu and choose Duplicate.
Or:
Press CTRL+C.

The server node is duplicated and appears in the list of nodes for this operating system.
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Deleting a Duplicated Server Node

Only node duplicates can be deleted, that is, only logical views on physical nodes can be deleted.

For further information, see Deleting an Object.

Displaying the Properties of a Server Node

You can display information about a server node.

~ To display the properties of a server node

1  In the object workspace, select the appropriate server node.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.

A dialog box such as the following appears. The content of this dialog box depends on the
node which has been selected. Example for z/OS:
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& MN - 148 Properties Node =]

— System —Date
Identifier: DAEF Local date: 20071214
Type: kA5 AE S Local hirme; 124530
Releaze: SF7.0.8 Difference to GMT: +1
CPLU I0: DO0F&10E Diate of last IPL: 2007-12-11
kM odel: 2036 Time of lazt |PL: 07 30:52

— Spool
Type: JESZ
Releaze: z/051.8

— Entire Syztem Server

Mode: 143

Job name:  XCOR143
Identifier:

Wersion: 332
Security; RACF
Auta logor: YES

APF: TES

SHF: 0

Ok

The following information is provided in this dialog box:

Group |Option Node Type Description
Box
System |Identifier All Logical identifier of the node.
Type All Operating system type.
Release All Release number of the operating system.
CPUID z/OS and z/VSE only |CPU identification number.
Model z/OS and z/VSE only [Machine-type number of the CPU.
Configuration name |OSD only Hardware type (for example, 7500- H60-F).
LMS version OSD only Version of Library Maintenance System which
must be used by this Entire System Server node
as specified in the startup parameters.
RSO version OSD only Version of BS2000 Remote Spool Output

subsystem which controls the output of remote
SPOOL jobs to decentralized printers.

Mainframe Navigation
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Group |Option Node Type Description
Box
Job variable OSD only States whether the BS2000 job variable software
product is installed. Possible values: YES, NO
Spool |Type z/OS and z/VSE only |Spooling system type.
Release z/OS and z/VSE only |Release number of spooling system.
Entire |Node All Node number.
gystem Job name All Job name of the Entire System Server node.
erver
Identifier All Logical identifier of the node.
Version All Version number of this Entire System Server.
Security All Security system defined in Entire System Server
startup parameters.
Auto logon All Automatic logon option for Entire System Server.
If "YES" is specified in the corresponding startup
parameter, Entire System Server will perform an
automatic logon to the active security system using
*INIT-USER as the user ID.
APF z/OS only States whether Entire System Server is running
APF-authorized. Possible values: YES, NO.
SMF z/OS only SMF record number written by Entire System
Server.
Mode OSD only Indicates the user mode of Entire System Server.
Possible values: SINGLE, MULTI.
Date |Local date All Current date in format YYYY-MM-DD.
Local time All Current time of day.
Difference to GMT |z/OS and z/VSE only | Time difference in hours between the local time
and GMT.
Date of last IPL z/OS and z/VSE only |Date of last system IPL in format YYYY-MM-DD.
Time of last IPL z/OS and z/VSE only |Time of last system IPL.

Issuing an Operator Command

You can issue operator commands to a server node.

~ To issue an operator command

1  In the object workspace, select the appropriate server node.

2 Invoke the context menu and choose Operate.

38
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The following dialog box appears:

ez MM - 148 Operate Node

Mode:; 148

=] E3

O perator commard: ||

.

Cancel

Help |

3  Enter an operator command.

4  Choose the OK button.

The dialog box is not closed so that you can enter further operator commands. All operator
commands that you have issued while the dialog box is open can be selected from the drop-

down list box.

To close the dialog box, choose the Cancel button.

Mainframe Navigation
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= Filtering an Object
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Listing an Object

When you display a list of objects (either in the object workspace or list view window), a default
filter is often applied automatically. In many cases, this is the ID that you have used to log on.
This causes that only those objects are shown where the names start with your user ID.

This section provides a brief overview on how to list objects so that they are shown in the list view
window. For information on how to list a specific type of object, see the appropriate section later
in this documentation.

The following topics are covered below:

= Opening the List View Window

= Defining a Different View

= Activating the Automatic Refresh
= Sorting a Column

= Resizing a Column

Opening the List View Window

The list view window provides detailed information about an object.

In the list view window, it is possible to select several objects at the same time (which is not possible
in the object workspace). This is helpful, for example, if you want to open several editor windows
at the same time.

When a filter has been applied to an object (see Filtering an Object), only the entries which satisfy
the filter criteria are shown in the list view window.

~ To open the list view window

1  Select an object in the object workspace.
2 Invoke the context menu and choose List.
Or:

Press Fs.

The list view window appears in the content pane. It shows a list of the subobjects contained
in the selected object. The following example shows a list of PDS members which appears
when you have selected a z/OS dataset:

42 Mainframe Navigation



Listing and Filtering Objects

iE *[BRY.COMN.SOURCE] List Members =0 =]
| Member | WiMM | Created [ Modified | siee] wit] 7o |0 |2
[EJABBREYS | 0102 13900310 200303251443 13 17 BRY
FEJAGENDA 0112 19891205 200309251450 27 1 BRY
[El4PPLYMI0 0103 19970722 200303251450 46 42 BRY
MEl&PPLYMI?  01.02 19970722 200303251451 22 21 BRY
FElePPLYMOD 0107 19961210 200303251451 76 35 BRY
Pl COMPRESS 1983-12-18 0334 5 80 BTO
FElcoNDOCS 0101 19341223 199412-2316:43 1020 1020 BRY
ElDooNFD 0102 19951122 200303251452 83 &9 BRY
FElDOCPROJS 0116 19950629 200303251452 61 14 BRY
EEovizi 0110 19960823 200303251452 82 90 BRY
FElESMDOKU 0102 19960228 2003-09-25 1453 7 B BRY
MElESMPRO) 0134 19960214 200303251453 76 31 BRY
FElESMPROJZ 0107 19960311 200303251453 84 75 BRY
FElESMPROT 0189 19960228 199603081608 293 198 BRY
FElESMwWKSHP 01.02 19960807 199608071455 20 20 BRY
FEIHELP 01.04 19930202 199302021513 71 51 BRY
FEIHELPT 01.99 19930203 199302081727 153 63 Ry ]

You can select an entry in the list view window and invoke a context menu containing the

commands which can be used with this entry.

Defining a Different View

By default, the content of a list view window is shown in details view. You can also define another
view (for example, large icons).

> To define a different view

1  Activate the list view window.

2 Invoke the context menu and choose one of the following commands from the View menu:
Large Icons, Small Icons, List or Details.

The type of view which is currently active is always indicated by a check mark.
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Activating the Automatic Refresh

By default, the automatic refresh is not active.

When the automatic refresh is active, the content of the active list view window is refreshed ac-

cording to the specified time interval.

| Note: Each list view window has its own auto refresh settings.

~ To activate the automatic refresh

1  Activate the list view window.

2  Invoke the context menu and choose Auto refresh.

The following dialog box appears:

—&uto refresh
©on O off

Auto refresh E |

—Time interval (sec)————

] v

ZIH

Cancel

3 Select the On option button to activate automatic refresh.

4  Inthe Time interval spin box, specify the interval in seconds after which the list view window

is to be refreshed.

5 Choose the OK button.

Sorting a Column

In details view, you can use the mouse to sort the columns in ascending or descending order.

> To sort a column

m  Click the header of a column.

An arrow in the header indicates the sort direction. With each click on the same header, the

column in sorted in the opposite direction.
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Resizing a Column

In details view, you can use the mouse to change the width of each column. This change is only
valid as long as the list view window is open.

You can also resize a column in such a way that it is not longer visible. If you want to redisplay
the column, close the list view window and then open it once more. Or if you still know at which
position the column is hidden, move the mouse pointer to this position in the header and resize
it as described below.

> To resize or hide a column

1 Move the mouse pointer to the line in the header which separates two columns.

The pointer changes, showing two arrows pointing into opposite directions.

2 Use the mouse to drag the column until it has the desired width or until it is no longer visible.

Filtering an Object

This section provides a brief overview on how to filter objects. For information on how to filter a
specific type of object, see the appropriate section later in this documentation.

Before listing the objects contained in a specific folder, you might want to employ a filter in order
to reduce the number of shown objects. Only the objects which satisfy the filter criteria will then
be listed.

The filter criteria last entered are used the next time you invoke the corresponding list view window
or when you expand the corresponding folder in the tree. These filter criteria are retained even
after the session has ended and will be used the next time you start Mainframe Navigation.

When specifying filter criteria, you can use the following wildcard characters:

" Asterisk
An asterisk (*) selects object names with any character string. For example, when you specify
"FSM*6", all object names are selected which start with "FSM" and end with "6" ("FSM006" or
"FSMO016"). If "6" is located at an unknown position within the name, you specify the name as
"FSM*6*" in order to also select names such as "FSM600" or "FSM061".

® Underscore
An underscore (_) selects object names with one character in the place of each underscore. For
example, when you specify "FSM_6", object names such as "FSM06" or "FSM16" are selected.

Take care, when an object name contains dots as delimiters. It is not possible to use an underscore
instead of a dot. For example, it is possible to specify "KO_._B*", but is not possible to specify
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"KO___B*". As a rule, underscores should only be used with for objects with names. It is not
possible to use them for volumes which are offline.

When a filter has been applied to a folder or when a folder is not available, this is reflected in the
folder icon that is shown in the tree view of the object workspace:

£ A filter has been applied. This means that the number of items in this folder has been reduced according

to specific filter criteria. Different filters can be defined for the different types of folders. For further
information, see the appropriate sections later in this documentation.

#§ The folder is not available. This is due to the security settings in your mainframe environment.

> To define a filter

1  Select the appropriate object (either in the object workspace or list view window).
2 Invoke the context menu and choose Filter.
Or:
Press F3.
A dialog box appears. The filter criteria that can be defined in this dialog box depend on the
object which has been selected. The following example shows the dialog box which appears
when have selected the folder which contains the z/OS datasets.
B MN - Filter Datasets
Mode: 148
D ataset name:; ||
Y olurie: I
Fazzward: I
k. Cancel Help
|Enter dataset name.
When a filter has already been defined for the selected object, the filter criteria are shown in
this dialog box.
| Note: For several objects, a Filter Subobject command is also available. See the appro-
priate section later in this documentation for information on the resulting dialog box.
3  Enter the filter criteria. For example, in the above dialog box, enter a dataset name such as
the following;:
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JWO.COMM. *

Choose the OK button.
The filter is immediately reflected in the object workspace.

When the Filter command has been invoked from the list view window, the change is also
immediately reflected in this window.
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General Information

The commands described in this chapter work similarly with all types of objects. The descriptions
below are not repeated in later sections of this documentation which deal with the different types
of objects.

Editing an Object

You can edit datasets, files, members, LMS elements and LMS element versions.

When you edit an object, an editor window appears in which you can modify the content of the
object.

~ To edit an object

1  Select the appropriate object (either in the object workspace or list view window).

2  Invoke the context menu and choose Edit.

z/VSE files only: A dialog box appears in which you enter your preferences for editing the
file. You then have to choose the OK button to display the editor window.

.-ﬂ MATURAL.QA.TEST.NPR.P5 Edit ¥SE File il
MNode; 55521
Library/D atazet name: MATLIRAL QA TEST MPR.PS
Wolurne: NATGO3
W5Ak catalog:
Becord format: FE
Record length: IED
Block gize: IEEI

] Cancel Help

|Enter record format,

| Note: This dialog box only appears for z/VSE files, not for other types of objects.

The selected object appears in an editor window in the content pane (the example below
shows a z/VSE file).
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BT NATURAL.QA.TEST.NPR.PS Edit ¥SE File = ||:||£|
RECORD ONE SCAHBAe1 EHD =
RECORD TwO SCANBBA2 EHD
RECORD THREE SCAHBO003 EHD
RECORD FOUR SCAHBOB4 EHD
RECORD FIVE SCAMAAAS EHD

[

In addition, the Edit menu is now shown in the menu bar and a special toolbar for the editor
appears. See Commands for Editing an Object.

3 Apply all required changes to the object.

4  From the Object menu, choose Save to save your changes in the editor window.
Or:

Choose the following toolbar button.

Or:
Press CTRL+S.

A dialog box appears informing you that the object has been saved.

5  From the Object menu, choose Close to close the editor window.
Or:
Choose the following toolbar button.
E
Or:
Press CTRL+F4.
Or:
Or choose the standard close button at the top right of the window.

When you close the editor window and recent changes have not yet been saved, a dialog box
appears asking whether you want to save the changes. You have to choose one of the following
command buttons:
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Command Button|Description

Yes Save the changes and close the editor window.

No Abandon the changes and close the editor window.
Cancel Return to the editor window.

Commands for Editing an Object

The following table lists the editing commands that are available in an editor window. The com-
mands can be invoked from the Edit menu, or from a context menu which is invoked directly in
the editor window. In addition to the commands, the following table also lists the toolbar buttons
and shortcut keys that can be used instead of a command.

Toolbar Button |Command Shortcut Key | Description

K Undo CTRL+Z |Undo the last editing step.

ru Redo CTRL+Y |Redo an “undone” editing step.

£ Cut CTRL+X |Cut a marked section of code or text and copy it to the clipboard
for pasting to another position in the editor window or to an
external editor.

Copy CTRL+C |Copy a marked section of code or text to the clipboard for pasting
to another position in the editor window or to an external editor.

2] Paste CTRL+V  |Paste a section of code or text to a selected position the editor
window.

by Delete DEL Delete a marked section of text or code.

= Select All CTRL+A  |Select all code or text in the editor window.

i Find CTRL+F |Find a string of text or code. A dialog box appears in which you
can enter search criteria.

i3 Find Next F3 Find the search string again.

Replace CTRL+H |Find and replace all instances of a string of code or text. A dialog
box appears, in which you can enter selection criteria for the
search, and enter code or text for the replacement.

s Replace Next| CTRL+F3 |Find and replace the next instance of a string of code or text. A
dialog box appears, in which you can enter selection criteria for
the search, and enter code or text for the replacement.

i Go To CTRL+G  |Go to a specified line of code or text. A dialog box appears in
which you can enter the line number.

= Print CTRL+P  |Print using the standard Windows functionality.

B Submit - Submit the object as a job.
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Browsing an Object

You can display an object in read-only mode. The content of the object is then displayed a browse
window. You can copy the contents, but you cannot modify it.

You can browse all objects which can also be edited. In addition, it is also possible to browse sysout
datasets, jobs and active jobs.

Browsing is limited to a record length of 2500 bytes. If a record is longer, it is truncated and only
the first 2500 bytes are displayed.

~ To browse an object

1  Select the appropriate object (either in the object workspace or list view window).

2 Invoke the context menu and choose Browse.
Or:
Press CTRL+B.
z/VSE files only: A dialog box appears in which you enter your preferences for browsing the

file. You then have to choose the OK button to display the browse window.

#5: CU37XX.LOAD-FILE Browse YSE File X|

Mode: 11

Library/Datazet name: CU3F LOAD FILE
Yiolurne: STEwWE

WSAM catalog:

Record format:

Record length:

11

Block zize:

] Cancel Help

|Enter record format.

| Note: This dialog box only appears for z/VSE files, not for other types of objects.

The selected object appears in a browse window in the content pane (the example below
shows a z/VSE file).
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BT NATURAL.QA.TEST.NPR.PS Browse ¥SE File =10l =l
Hum | Text |

1| RECORD OHE  SCAN@GAA1 END

2| RECORD Tuo SCANBBA2 EHD

3| RECORD THREE SCANGODZ END

4 RECORD FOUR SCAHOGAY EHD

5| RECORD FIUVE SCANOBAS EHD

In addition, the Browse menu is now shown in the menu bar and a special toolbar for browse
mode appears. See Commands for Browsing an Object.

3  From the Object menu, choose Close to close the browse window.
Or:
Choose the following toolbar button.
1
Or:
Press CTRL+F4.
Or:

Or choose the standard close button at the top right of the window.
Commands for Browsing an Object

The following table lists the browsing commands that are available in a browse window. The
commands can be invoked from the Browse menu, or from a context menu which is invoked directly
in the browse window. In addition to the commands, the following table also lists the toolbar
buttons and shortcut keys that can be used instead of a command.
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Toolbar Button |Command Shortcut Key |Description

Copy CTRL+C |Copy a marked section of code or text to the clipboard for
pasting to an external editor.

Not available. |[Reverse Order| CTRL+R |Reverse the line order of code or text in an object. The last line
appears at the top of the browse window, the first line at the
bottom.

Not available. |Refresh F5 Refresh text or code in the browse window.

i Find CTRL+F  |Find a string of text or code. A dialog box appears in which
you can enter search criteria.

i% Find Next F3 Find the search string again.

3 Go To CTRL+G  |Go to a specified line of code or text. A dialog box appears in
which you can enter the line number.

Print CTRL+P  |Print using the standard Windows functionality.

i

Copying an Object

You can copy datasets, files, members and LMS elements.

When you copy an object, a new instance of that object is created at the location that you specify.
For example, you can copy a z/OS dataset to a different z/OS node or to a BS2000 file.

| Note: The Copy command described in this section is different from the standard Windows

Copy command. It does not copy any information to the Windows clipboard. Instead, it
immediately places the copied object at the specified location (without the need for a Paste
command).

~ To copy an object

1
2

The following dialog box appears:

rﬂ MM - BLI.LEDIT.TST Copy Dataset

Target object type:

Ok,

Cancel

Select the appropriate object (either in the object workspace or list view window).

Invoke the context menu and choose Copy.

|Select object ype,
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3  From the drop-down list box, select the target object type (dataset, member, z/VSE file, librar-
ian member, OSD file, or LMS element).

4  Choose the OK button.

The dialog box for the selected target object type appears.

5  Specify the information for the target object type as described below in the appropriate section.

] Note: If this is the first time you are copying to the object type and if the source and

target types are identical, the default values for the target object are taken from the
source object. The next time the object type is selected, the previously entered values
are used by default.

6  Choose the OK button.
The following topics are covered below:

= Copying an Object to a Dataset

= Copying an Object to a PDS Member

= Copying an Object to a z/VVSE File

= Copying an Object to a Librarian Member
= Copying an Object to an OSD File
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= Copying an Object to an LMS Element

Copying an Object to a Dataset

"ﬂ MM - BLL.LEDIT.TST Copy Dataset

— T arget object tupe D atazet

Mode: |1 43

[Datazet name: |HR=EINEN]

W olurme; I
Pazszword: I

[ Canicel Help

|Enter dataset name.

| Note: If you are copying from a dataset, the Node and Dataset name text boxes contain the

dataset default values.

You can specify the following information:

Option Description

Node The name of an Entire System Server node.

Dataset name |A target dataset name.

Volume The serial number of the volume, if the dataset is not cataloged.
Password A system password, if the dataset is to be protected.

The selected object will be copied to the specified dataset. If the target dataset does not exist, it
will be allocated, if possible.

If you are copying from a dataset, the new dataset is automatically cataloged and appears in the
Datasets folder.
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Copying an Object to a PDS Member

.'n MM - BLLEDIT.TST Copy Dataset

— T arget object kype Member

Mode: |1 43

Drataget name:; ||

b ember: I

Yolurme; I
Pazswaord: I

[ Replace target object

] Caricel Help

|Enter datazet name.

| Note: If you are copying from a PDS member, the Node, Dataset name and Member text
boxes contain the member default values.

You can specify the following information:

Option Description

Node The name of an Entire System Server node.

Dataset name The name of the dataset which will contain the new member.

Member A target member name.

Volume The serial number of the volume on which the target dataset resides (required only
if dataset is not cataloged).

Password A system password, if member is to be protected.

Replace target object | Activate this check box, if you are copying to a member which already exists.

The selected object will be copied to the specified member.
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Copying an Object to a z/VSE File

.'n MM - BLLEDIT.TST Copy Dataset

~ Target object type YSE File
Mode: ||—
Libram /D atazet name: I
olurne: I—
WS4 catalog: I—
Password: I—
Record format: I—
Fecord length: I—
Block size: I—
[ | Canicel Help
|Enter node.

| Note: If you are copying from a z/VSE file, the Node, Library/Dataset name, Volume, VSAM

catalog and Record format text boxes contain the file default values.

You can specify the following information:

Option

Description

Node

The name of an Entire System Server node.

Library/Dataset name

A name for the new dataset.

Volume For non-VSAM installations: required only if the dataset has no label definition. The
serial number of the volume on which the target dataset resides.

VSAM catalog For VSAM installations: required only if the dataset has no label definition. A VSAM
catalog name for the target database.

Password A system password, if dataset is protected.

Record format

A record format, for example:

FB Fixed block.

VB Variable block.

FBA Fixed block, ANSI control characters.
Record length The logical record length in bytes.
Block size The block size in bytes.
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The selected object will be copied to the specified z/VSE file. If the target file does not exist, it will
be allocated, if possible.

Copying an Object to a Librarian Member

BE: MN - BLLEDIT.TST Copy Dataset

— Target object type Librarian Member

Mode: ||

Libram/D atazet name:

Sub library: I [~ MSHF protect
ember: I Irline data
bember type: I ; e

* Mo
Wolurme: I 0
WS40 catalog: I

Fazsword: I

[ Replace target object

[IF Cancel Help

|Enter node.

| Note: If you are copying from a librarian member, the Node, Library/Dataset name, Sub-

library, Member, Member type, Volume and VSAM catalog text boxes contain the member
default values.

You can specify the following information:

Option Description

Node The name of an Entire System Server node.

Library/Dataset The name of the dataset which will contain the new member.

name

Sublibrary The name of the sublibrary which will contain the new member.

Member A name for the target member.

Member type A type for the target member. Members can be grouped and listed according to a
user-defined type, which you can specify here.

Volume For non-VSAM installations: required only if the dataset has no label definition. The
serial number of the volume on which the target dataset resides.
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Option Description

VSAM catalog For VSAM installations: required only if the dataset has no label definition. The name
of the VSAM catalog which will contain the target member.

Password A system password, if dataset is protected.

Replace target object| Activate this check box, if you are copying to a member which already exists.

MSHP protect Activate this check box to bypass MSHP protection; otherwise, leave this check box
blank (relevant only for the Edit command).
Inline data Relevant only for the Edit command. Choose one of the following option buttons:
Yes Indicates that the member contains SYSIPT
data.
No Indicates that the member does not contain
SYSIPT data.
Off Switches off the SYSIPT flag for the existing
member.

The selected object will be copied to the specified librarian member.
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Copying an Object to an OSD File

.'n MM - BLLEDIT.TST Copy Dataset

— T arget object type OS50 File
Mode:

File name:

||
|
Pazzword: I

[~ Feplace target object

[ Cancel Help

|Enter node.

| Note: If you are copying from an OSD file, the Node and File name text boxes contain the
file default values.

You can specify the following information:

Option Description

Node The name of an Entire System Server node.

File name A target file name.

Password A system password, if file is protected.

Replace target object | Activate this check box, if you are copying to a file which already exists.

The selected object will be copied to the specified OSD file.
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Copying an Object to an LMS Element

.'n MM - BLLEDIT.TST Copy Dataset

— T arget object twpe LMS Element

MHode: ||

File name:

Type:

|
Element: I
|
|

W erzion;

Pazzword: I

[~ Feplace target object

[ Cancel Help

|Enter node.

| Note: If you are copying from an LMS element, the Node, File name, Element text boxes

and the Type drop-down list box contain the element default values.

You can specify the following information:

Option Description

Node The name of an Entire System Server node.

File name The name of the file which will contain the new element.

Element The name of the target element.

Type A type for the target element. For example: S - source program, M - assembler macro.
Version A version number for the target element.

Password A system password, if element is protected.

Replace target object|Activate this check box, if you are copying to an element which already exists.

The selected object will be copied to the specified LMS element.
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Deleting an Object

You can delete datasets, files, members, z/OS and z/VSE jobs, sysout datasets, LMS elements and
element versions, BS2000 job variables, and duplicated nodes.

~ To delete an object

1
2

Select the appropriate object (either in the object workspace or list view window).

Invoke the context menu and choose Delete.
Or:
Press DEL.

A dialog box appears, asking to confirm the delete function for the selected object.

Choose the Yes button to delete the object.

Renaming an Object

You can rename datasets, files, members, LMS elements and element versions, and BS2000 job
variables.

~ To rename an object

1 Select the appropriate object (either in the object workspace or list view window).
2 Invoke the context menu and choose Rename.
Or:
Press F2.
The name is selected so that you can immediately enter a new name. Any text you enter
automatically deletes the selection.
| Note: If you want to cancel your modifications, press EsC.
3  Enter a new name for the object.
4 Press ENTER.
Or:
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Click any other position in the object workspace or list view window.

Sending an Object to an E-mail Recipient

You can send datasets, files, members, sysout datasets, z/VSE jobs, LMS elements and element
versions to one or more e-mail recipients.

~ To send an object to an e-mail recipient

1  Select the appropriate object (either in the object workspace or list view window).

2  Invoke the context menu and choose Send To.

A dialog box appears. The following example shows the dialog box which appears when you
have selected a dataset.

.'n MM - BLLEDIT.TST Send To Dataset

Lo I

Subject; IELI.EDIT.TST Send To D atazet

Comment;

] Cancel Help
|Enter recipient|s] separated by a semicolon.
3  Specify the following information:
Option Description
To Enter the e-mail address of the recipient. If you want to send the object to more than one

recipient, use a semicolon to separate the e-mail addresses.

Cc Optional. Enter the e-mail address of one or more persons who are to receive a copy (Cc).

Subject |Optional. Change the default subject heading.

Comment|Optional. Enter a short message.
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4 Choose the OK button to send the object.
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IV Managing z/OS Objects

This part covers the following topics:

z/OS Datasets

PDS Members

z/OS Volumes

z/OS Jobs

z/OS Sysout Datasets

z/OS Active Jobs

Support of Natural ISPF Object Exits under z/OS
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8 z/0OS Datasets

= Filtering z/OS Datasets .............cccccvveeenns
= Listing z/OS Datasets ...........ccccceevvvvnrnnn
= Managing Recent z/OS Datasets ..............
= Cataloging a z/OS Dataset ......................
= Uncataloging a z/OS Dataset ...................
= Compressing a z/OS Dataset ...................
= Allocating a z/OS Dataset .......................

= Displaying the Properties of a z/OS Dataset
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z/0S Datasets

In the object workspace, the z/OS datasets are shown when you expand the Datasets folder of a
z/OS node. Example:

EI@ M ainframe M avigation
-G8 05390 Nodes

=-F] 148<DAEF:
: Eﬁ Datazets
© L) w0 COMNALLOC
o f=) Jw/0.COMN.BIGNEL

Filtering z/OS Datasets

Before displaying z/OS datasets, you can define a filter so that only those datasets are shown which
correspond to your filter criteria.

> To define a filter

1 In the object workspace, select the Datasets folder in the appropriate node.

2  Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:

B MN - Filter Datasets

M ode:

D atazet name:
“Walurme:

Pazzwiord:

k. Cancel Help

|Enter dataset name.

3  Enter the filter criteria.
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Option Description

Dataset name |Enter the datasets that are to be shown. For example, when you specify "ABC*", only
the dataset names starting with these characters will be shown.

Volume If you do not specify a volume, the dataset list is created from the catalog.

If you do specify a volume, the dataset list is created from the VTOC of that volume.

Password Enter the system password if dataset is protected.

4  Choose the OK button.

Listing z/OS Datasets

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the datasets (see Filtering z/OS Datasets).

> To list z/OS datasets

1  In the object workspace, select the Datasets folder in the appropriate node.

2 Invoke the context menu and choose List.
Or:
Press Fs.
The list view window appears.

The type of information contained in the list view window depends on whether or not filter
criteria for Volume have been defined (see Filtering z/OS Datasets).

The following topics are covered below:

= No Volume has been specified
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= A Volume has been specified
No Volume has been specified

When a volume has not been specified with the Filter command, the dataset list is created from
the catalog. Example:

&5 IW0.* List Datasets =10] x|
£ Dataset Mame | Yalurne | Seriesl Clazs | Type |;
L w0 COMM ALLOC | DCMOMO - 3330 | DASD WNOMWSAM

g /0. COMMN BIGHEL DCHOTO 3390 DaSD MOMNYSAM
L@ WO COMNBIGNEL22  DCNOIO 3390 DASD  MOMYSAM
L@ WO COMNBIGNEUZ3  DCNOID 3390 DASD  MONYSAM
L@ wWO COMN.CATTESN  DCNOIO 3330 DASD  MOMNYSAM
Lgfw/0.COMN.CPTEST COmMa11 3380 DaSD MOMNYSAM
L@ WO COMNDEMOGGE  DCNOTO 3390 DASD  MOMYSAM

L /w0 COMN DEMOGGGT Ma- GDG

L w0 COMN EMPTY COMZ1T 3380 DaSD  MOMNYSAM
Lgf 0. COMMN.ICLY COME1T 3380 DaSD HOMNWSAM
LR w0 COMN L1332 DCWOTO 3330 DaSh MOMWSAM
LEf w0 COMN L1334 DCMOTO 3330 DaSDh  MOMNYSAM
Lg w0 COMN L1338 DCWOTO - 3350 DaSDh MOMYSAM
LEf /0. COMMN. L2500 DCWOTO 3390 DaSD HOMNYSAM
L JwO . COMN L300 DCWOTO 3330 DaSh MOMWSAM
Lgf w0 COMN L3004 DCWOTO - 33530 DasSDh MOMYSAM
g /0.COMM.LED DCHOTO 3390 DaSD MOMNYSAM
L JwO COMN LTEST DCWOTO 3390 DaSD HOMNYSAM

L@ w0 COMN MARCONEL DCNOTOD 3390 DASD  MONYSAM
L /w0 COMN MARCOX  DCNOIO 3330 DASD  MOMNYSAM
L Ww0.COMNNEWSOR  COMB11 3380 DASD | MOMWSAM
L w0 COMN 0B DCWOTO 3330 DaSh MOMWSAM ll

Since no volume was specified, the list of datasets appears as shown above with the following
columns:

Column Description

Dataset Name | Name of the dataset.

Volume Volume serial number.

Series Device series.

Class Device class. Possible values:
COMM Communications.
CTCA Channel-to-channel adapter.
DASD Direct access.
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Column Description
DISP Display station.
NA Not applicable.
TAPE Tape.
UREC Unit record.
Type Dataset type, for example: NONVSAM, CLUSTER, DATA, GDG BASE.

A Volume has been specified

When a volume has been specified with the Filter command, the datasets contained in the VTOC
of the specified volume are shown. Example:

B5: IW0.* Yolume=DCNO10 Lisk Datasets - |EI|1|
£ Dataget Mame Organization | Aecord Length | Block Size | Record Formatl C_l,llinderl Trackl c'/=Usecll Created Last Access I 5SS | Update 2
& P5 0080 00200 FB 12 D 95 20010703 20030827 NO  ND

COMN. 2 PS 00080 00200 FB 12 0 120030130 20030827 NO  ND

il o COMM BIGNEU2Z  PS 00080 00200 FB 12 0 0 20030130 20030130 NO  ND
L@ Jw0.COMN.CATTESN PO DoDE0 . 0320 FB 1 D 13 20000510 20030303 NO | NOD
L@ Jw0.COMN.DEMOGGE | PO 00080 03120 FB 1 0 § 20020611 20030303 NO  ND
Bl i COMN.L133 P5 003 01330 FB 0 5 B0 20010813 20030613 NO | ND
EH w0 COMN L1334 P5 003 01330 FB 0 5 B0 20021217 20030526 NO  NO
i=H Jwio.cOMN L1338 P5 00133 01330 FB 0 5 20 20021217 20030612 MO ND
i w0 COMN L2500 P5 02500 25000 FB 0 5 0 20021219 20021213 NO  ND
HEH w0 COMN.L200 P5 00300 03000 FB 0 5 20 20021120 20030612 NO | ND
#=H Jwio.cOMM. L3004 P5 00300 03000 FB 0 5 0 20030326 20030326 NO  NOD
#=H w0 COMM.LED P5 00080 00200 FB o1 10 20020724 20030618 NO | NOD
HEH w0 COMN LA P5 0080 00200 FB 010 0 20030612 20030612 NO  ND
#=H Jwio . COMM.LTEST P5 00080 00200 FB 0 2 50 20010206 20030316 MO NOD
L Jw0.COMN MARCONEU | FO 00080 03120 FB 3 0 17 20020531 20030324 NO | ND
L Jw0.COMN MARCOX | PO ooDs0 0320 FB 3 0 B 20020725 20030317 NO ND =]

Since a volume was specified, the list of datasets appears as shown above with the following
columns:

Column Description

Dataset Name |Name of the dataset.

Organization |Dataset organization, for example:

DA Direct access.

PO Partitioned dataset (PDS).
POE Partitioned dataset (PDSE).
PS Sequential dataset.

Record Length |Logical record length in bytes.

Block Size Block size in bytes.

Record Format|Record format, for example:

F Fixed length record.
FB Fixed blocked record.
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Column Description
FBA Fixed blocked record, ANSI control characters.
U Unformatted record.
\Y% Variable record.
VB Variable blocked record.
Cylinder Size of dataset in cylinders.
Track Size of dataset in tracks.
%Used Percentage of dataset used.
Created Dataset creation date.

Last Access

Date of last access.

SMS

Is this an SMS-controlled device/unit (YES, NO)?

Update

Has the file been updated since the last backup (YES, NO)?

Managing Recent z/OS Datasets

Mainframe Navigation internally maintains a list of the 100 datasets most recently accessed by
the user. This list is stored at the end of a session and is read when Mainframe Navigation is

started.

The following topics are covered below:

= | isting Recent z/OS Datasets
= Removing a z/OS Dataset from the List of Recent Files
= Synchronizing the List of Recent Files for z/OS Datasets

Listing Recent z/OS Datasets

All commands that are available for datasets can also be invoked from the list of recent files.

~ To list recently-used z/OS datasets

1 In the object workspace, select the Datasets folder in the appropriate node.

2 Invoke the context menu and choose My Recent Files.

The list view window containing recently-used datasets appears in the content pane. Example:

74

Mainframe Navigation



z/0S Datasets

B Mode=148 My Recent Files 05390 Nod =0 =|
£ Dataset Name | "-.r‘u:ulumel Organization | Last Access I
LgEERY COMM SEQAD : 20030317 11:47:44
LEgBERY COMM SOURCE 2003-09-2312:24:09
Lg./0.COMM BIGMEIZ3 2003-03-23 15:03:13
Lg w0 COMN PDSLEER 2003-03-23 15:09:29
Lgf w0 COMN SALLBDE 2003-09-23 15:09:19
L0, COMN SEQT 2003-08-23 15:09:43
L w0 COMN SRCE 2003-03-23 15:09:48
Lgg w0 TEST SEQS0 2003-03-23 15:08:45
LEf w0 TEST SETVED 2003-09-23 15:08:48

The list view window contains the following columns:

Column Description

Dataset Name |Name of the dataset.

Volume Volume serial number.

Organization |For example: PO (PDS), PS (sequential dataset), DA (direct access).
Last Access |Date (YYYY-MM-DD) and time the dataset was last accessed.

Removing a z/OS Dataset from the List of Recent Files

You can remove a dataset from the list of recent files. This does not delete the dataset on the
server.

> To remove a z/0S dataset from the list of recent files

1 In the list of recent files, select the dataset to be removed.

2 Invoke the context menu and choose Remove from list.
Synchronizing the List of Recent Files for z/OS Datasets
You can synchronize the list of recent files with the data on the server. List entries which no longer

exist on the server (for example, because they have been renamed or deleted) are deleted from the
list of recent files.

~ To synchronize the list of recent files for z/0S datasets

1  In the object workspace, select the Datasets folder in the appropriate node.

2 Invoke the context menu and choose Synchronize.
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A dialog box appears, asking to confirm the synchronize function for the selected object.

3 Choose the Yes button to synchronize the list of recent files.

Cataloging a z/OS Dataset

You can add a z/OS dataset to a catalog.

~ To catalog a z/OS dataset

1  Inthe object workspace, select an uncataloged dataset in the Volumes folder of the appropriate
node.

2 Invoke the context menu and choose Catalog.

The dataset is cataloged. It will appear in the Datasets folder (depending on your filter criteria).

Uncataloging a z/OS Dataset

You can remove a z/OS dataset from a catalog.

~ To uncatalog a z/OS dataset

1 Inthe object workspace, select a cataloged dataset either in the Volumes or Datasets folder
of the appropriate node.

2 Invoke the context menu and choose Uncatalog.

A dialog box appears, asking to confirm the uncatalog function for the selected object.

3 Choose the Yes button to uncatalog the dataset.

The selected dataset is uncataloged and removed from the Datasets folder.

Compressing a z/OS Dataset

You can compress a partitioned z/OS dataset (PDS).

~ To compress a z/0S dataset

1 Inthe object workspace, select a partitioned dataset either in the Datasets or Volumes folder
of the appropriate node.
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2 Invoke the context menu and choose Compress.

A dialog box appears, asking to confirm the compress function for the selected object.

3 Choose the Yes button to compress the dataset.

Allocating a z/OS Dataset

This command is generally issued for an existing dataset. The allocation information for the existing
item is displayed and you can overwrite the name and modify the specifications for the new item.

> To allocate a z/OS dataset

1 In the object workspace, select a dataset either in the Datasets or Volumes folder of the ap-
propriate node.

2  Invoke the context menu and choose Allocate.

The following window appears in the content pane:
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B35 MN - Allocate Dataset =] B3
— Dataszet
Pode:
I armne;
Yolume: |FSMEI14 | | | |
Device type: ISSEIEI
Organization: IF'EI VI Record farmat; IFB
Allocation wpe: ITHK VI Record length: 133
First extent: I'I 1 Block size: I'I 3300
Second extent; I'I Diirecton blocks: I'I
¥ Catalog dataset [T Release [T Contiguous [~ Round
E wpiration date: I Sh5S attributes
b b class: IDEF.-’-‘-.LILT
GDG attributes ANAQEMErt £15s
GOG limit; IEI Storage clazs: ShS5
[~ Empty all [~ DSCE clear [rata clazs: I
[F | Cancel I Help

3  Enter a new name for the dataset and enter or change other options as described in the table
below.
Option Description
Node Node containing the dataset.
Name Dataset name.
Volume Serial number of the volume on which the dataset is to be allocated. You can specify
up to 5 volumes for multi-volume datasets.
Device type If you do not specify a volume, specify the generic identifier from which a volume
is to be selected (for example, 3380).
Organization |For example: PO (PDS), PS (sequential dataset), DA (direct access).
Allocation type |Space type for dataset. Possible values:
BLK Blocks
CYL Cylinders
TRK Tracks
First extent Initial quantity to be allocated.
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Option

Description

Second extent

Additional quantity to be allocated if dataset fills.

Record format

For example:

FB Fixed block
VB Variable block
FBA Fixed block, ANSI control characters

Record length  |Given in bytes.
Block size Given in bytes.
Directory blocks | Must be specified for PO-type datasets.

Catalog dataset

Activate this check box to automatically catalog the dataset when it is allocated.

Release Activate this check box to release allocated space if it is not used by the dataset.
Contiguous Activate this check box if tracks or cylinders must be adjacent.
Round Activate this check box to automatically round up space to the nearest cylinder if

tracks or blocks are specified as space units.

Expiration date

Date when the dataset expires. Until this date is reached, each attempt to update or
delete the dataset causes a console message, requiring an operator reply.

GDG attributes

GDG limit A value in this field identifies the file to be allocated
as GDG. The value specifies the maximum number
of generation datasets that can be associated with

the GDG being defined.

Empty all Activate this check box to uncatalog all generation
datasets when the GDG limit is reached. If you do
not activate this check box, only the oldest

generation dataset is uncataloged.

DSCB clear Activate this check box to delete the dataset's DSCB
from the VTOC; the GDS no longer exists. If you
do not activate this check box, the DSCB is not
deleted from the VTOC and the dataset can be

processed as any non-VSAM dataset.

SMS attributes

These attributes are available only if SMS is installed.

Management class The management class to be used to obtain the
management-related data for SMS (migration,
backup and retention criteria) to allocate the

dataset.

Storage class The storage class to be used to obtain the

storage-related data for dataset allocation.

The data class to be used to obtain the data-related
information (SPACE, LRECL, etc.) for dataset
allocation.

Data class

Choose the OK button.
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A dialog box appears, informing you that the dataset was successfully allocated.

5  Choose the Yes button to allocate another dataset.
Or:

Choose the No button to finish allocation.

Displaying the Properties of a z/OS Dataset

You can display information about a z/OS dataset. Different types of information are shown for
sequential and partitioned datasets and for generation data groups (GDGs).

~ To display the properties of a z/0OS dataset

1  In the object workspace, select a dataset in the Datasets folder.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.
A properties dialog box appears.

The following topics are covered below:

= Sequential and Partitioned Datasets
= Generation Data Groups (GDG)

Sequential and Partitioned Datasets

The properties dialog box for a sequential or partitioned dataset looks as follows:
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'i IWO0.COMM.SALLOCS Properties Datasek

=10l |

— Datazet

M ame:

Yolume:
Device wpe:
Crganization:
Record format:
Record length:

Block, size:

Allocation type:

First extent:

Second extent;

Securby:

Creation date:

Last reference:

Jd0 COMM.SALLOCS

SM5m0
3390

PO

FE

a0

20

CvL

1 Gl
0
HOME

0 TRE

2002-05-21
2003-10-07

Allocated cylinders: 1
Allocated extentz: 1

Fercentage used: B

Espiration date:

Partitioned data zet
Mumber of members: 0
Directary blocks: 12
Urnused blocks: 1

Sh5S attributes

b anagement clazs; DEFALLT
Starage clazs: Sh45

Data class:

The following information is shown in this dialog box:

Option Description
Name Name of the dataset.
Volume Serial number of the volume on which the dataset is allocated.
Device type If a volume is not specified, this is the generic identifier from which a volume is to be
selected (e.g. 3380).
Organization For example:
PO PDS
PS Sequential dataset
DA Direct access

Record format For example:

FB

Fixed block

Mainframe Navigation
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Option Description
VB Variable block
FBA Fixed block, ANSI control characters
Record length Logical record length in bytes.
Block size Block size in bytes.
Allocation type Space type for dataset. Possible values:

BLK Blocks
CYL Cylinders
TRK Tracks

First extent

Initial quantity allocated.

Second extent

Additional quantity to be allocated if dataset fills.

Security Security status. Possible values:
NONE Not password-protected.
READ Password-protected for read and write
operations.
WRITE Password-protected for write operations.
Allocated Number of cylinders or tracks allocated.
cylinders/tracks

Allocated extents

Number of extents, 1 to 16.

Percentage used

Percentage of dataset used.

Creation date

Dataset creation date in format YYYY-MM-DD.

Last reference

Date of last access in format YYYY-MM-DD.

Expiration date

Date when the dataset expires in format YYYY-MM-DD. Until this date is reached,
each attempt to update or delete the dataset causes a console message, requiring an
operator reply.

Partitioned dataset

These fields appear only if the dataset is partitioned.

Number of members Number of members in the dataset.

Directory blocks Number of directory blocks.

Unused blocks Number of unused directory blocks.

SMS attributes These fields appear only if SMS attributes have been defined for the dataset during
allocation.

Management class The management class used to obtain the
management-related data for SMS (migration,
backup and retention criteria) to allocate the
dataset.

Storage class The storage class used to obtain the
storage-related data for dataset allocation.

Data class The data class used to obtain the data-related
information (SPACE, LRECL, etc.) for dataset
allocation.
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Generation Data Groups (GDG)

The properties dialog box for a generation data group looks as follows:

#5 ADABAS.UM.GDG.SIBA Properties Dak -0l x|

i ame:
Lirnit ruin

Empty all:

— Model D

— eneration data group

Crganization:
Record format:
Record length: 0

Block, size: 1]

ADABAS UM.GDG.SIEA

ber: 20
1]

DSCE clear: TES
Ewpiration date: 00000

SH attributes

The following information is shown in this dialog box:

Option Description

Name Name of the dataset.

Limit The maximum number of generation datasets that can be associated with the GDG being
number defined.

Empty all |When the maximum number of generation datasets is reached:

YES All generation datasets are uncataloged.

NO Only the oldest generation dataset is uncataloged.

DSCB clear |[When the generation dataset is uncataloged (due to the Delete command or Empty all value):

YES The dataset's DSCB is deleted from the VTOC and the generation
dataset is deleted.

NO The dataset's DSCB is not deleted from the VTOC. The DSCB is left
in the VTOC and the dataset can be processed as any non-VSAM
dataset.

Expiration |Date the dataset expires. Until this date is reached, each attempt to update or delete the dataset
date causes a console message, requiring an operator reply.

Model DSN |Organization For example: PO (PDS), PS (sequential dataset), DA (direct access).
attributes  [Rocord format For example:

Mainframe Na
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Option Description
FB Fixed block
VB Variable block
FBA Fixed block, ANSI control
characters
Record length Logical record length in bytes.
Block size Block size in bytes.
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In the object workspace, the PDS members are shown when you expand a partitioned dataset.

Example:

EI@ M ainframe M avigation

g3 05390 Nodes

= 148<DAEF:

Eﬁ Datazets

- =L@ BRY.COMM.SEQSE0
#-L@ BRY.COMN. SEQB04
- BRY.COMM.SOURCE
[E| ABBREVS

| AGEMDA

Filtering PDS Members

Before displaying PDS members, you can define a filter so that only those members are shown

which correspond to your filter criteria.

> To define a filter

1  In the object workspace, select the appropriate dataset in the Datasets folder.

2 Invoke the context menu and choose Filter Subobject.

Or:
Press CTRL+F3.

A dialog box appears.

fH MM - [BLI.EDIT.TST] Filter Subobject Members

M ode: 148

Dataset name: |BLI.EDIT.TST

tember; ||

“Walurme: I
Pazzwiord: I

Scan far: I

] 4

Cancel

Help

|Enter member name.
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3  Enter the filter criteria.

Option | Description

Member [The members that are to be shown. You can use a combination of strings and wildcards (*
and _) to display the members matching the member name pattern.

Scan for |When you specify a character string, only the members containing this string will be shown.

4  Choose the OK button.

Listing PDS Members

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the PDS members (see Filtering PDS Members).

> To list PDS members

1 Inthe object workspace, select the appropriate dataset in the Datasets folder.

2 Invoke the context menu and choose List.
Or:
Press Fs.
Or:

Choose the following toolbar button:

5

The members of the selected dataset are shown in the list view window.

The type of information contained in the list view window depends on whether or not a string
has been specified with the Scan for option of the filter criteria (see Filtering PDS Members).

The following topics are covered below:

= No String has been specified
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= A String has been specified

No String has been specified

When a string has not been specified with the Scan for option, all columns of the list are shown.

Example:

[ *[BRY.COMN.SOURCE] List Members =0 =]
| Member | wvitdnt | Created | T Modfied | Size] mit[Tn|D 2
FEINOM-FR  01.02 19960304 20030512 1610 3 3 BRY
F=lJoe 0118 19930825 2003-04-23 14:04 12 14 BRY
FElIEFBR14 0116 19930825 2003-04-2313.04 12 14 Jw0
= TLINES 01.34 19931002 2003-03-1810:39 24 18 FHI
FElaPPLYMS7  01.01 19970722 1997-07-2213:30 21 2 BRY
FElaPPLYMI0  01.02 19970722 1997-07-2211:18 542 BRY —
FEl4PPLYMOD  01.05 19961210 1997-02-07 10:57 ® B BRY
FEIREADEDZ  01.20 19960311 1996-091316:59 278 781 BRY
FEINOM135  01.07 19960829 1996-08-29 1551 23 @ BRY
EEovizi 01.09 19960823 1996-08-29 15.36 82 a0 BRY
FElESMwWKSHP 01.02 19960807 1996-08-07 14:55 200 2 BRY
FEINOPTERMS 01,93 19910820 199606141220 1696 7 BRY
FEITESTMAST  01.07 19960419 199604131635 353 326 BRY
FEIRESUME 0118 19960314 199603141742 120 89 BRY
FEIRESUMEZ  01.03 19960314 199603141219 118 117 BRY
FElESMPROJZ  01.06 199603171 1996-03-11 10:28 83 76 BRY
FElESMPROT  01.89 19960228 199603081608 299 198 BRY
FEINOMTERMS 01.85 19920812 199603061236 891 87 BRY

= maFR 01.01 19960304 1996-03-04 17.29 85 65 BRY
I?lz:‘.iINELGFH 01.01 19960304 1996-03.04 1657 7 7 IBFIY _I;I
4 3

The following columns are provided:

Column |Description

Member |Name of the member.

\AY Version number of the member. When a member is created, this field shows 01.

MM Modification level: shows the number of times the current version of the member has been
modified.

Created |Date the member was created.

Modified |Date and time of last modification.

Size Number of lines in member.

Init Initial size of this member.

TID Terminal ID at which the member was last modified.
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Column |Description
1D User who modified member last.
A String has been specified

When a string has been specified with the Scan for option, only the members which contain this
string are shown in the list. For example, when the string “active” has been defined, the list is

shown as follows:

fE NOM*[BRY.COMN.SOURCE] Scan—active Lisk Me

=10l x|

£ Member |Nun'||:uer| Firzt Recard

EIHOMTERMS : 3 Active Bundle Aktives Buendel
FEEI NOMVERIF 2 Ifthe ENTIRE 5YSTEM SERVER is active, proceed with

The following columns are provided:

Column Description

Member Name of the member.

Number The number of times the string occurs in the member.
First Record | The first line that contains the string in the member.

Adding a New PDS Member

You can add a new PDS member to a z/OS dataset.

> To add a new PDS member

1 In the object workspace, select the appropriate dataset in the Datasets folder.

2  Invoke the context menu and choose New.

Or:

Press CTRL+N.

An empty new member appears in an editor window in the content pane:
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§3 MN - UNTITLED[BLLEDIT.TST] New Member

3  Enter the data for the new member.

See also Commands for Editing an Object.

4  From the Object menu, choose Save As to save your data in the editor window.

The following dialog box appears.

§B UNTITLED[BLLEDIT.TST] New Member

M ode:; 148

D atazet name: |BLI.EDIT.TST

b ember: ||

Wolume: I
Pazzwiord: I

] ;8 | Cancel

Help

|Erter member narne.

5  Enter the following information:

90

Mainframe Navigation



PDS Members

Option Description

Member |A name for the new member.

Password |System password if dataset is protected.

| Note: It is recommended that you do not change any other values and keep the current

location for the new member.

Choose the OK button.

Submitting a PDS Member

You can submit a PDS member to the operating system.

> To submit a PDS member

Select a member in the object workspace or list view window.

Invoke the context menu and choose Submit.

Or:

Press CTRL+S.

A dialog box appears, confirming that the member has been submitted.

Follow mode is automatically activated. When the job has terminated, a corresponding message
is shown.

Displaying the Properties of a PDS Member

You can display information about a PDS member. Different types of information are shown for
normal PDS members and for PDS members of a load library.

~ To display the properties of a PDS member

1
2

Select a member in the object workspace or list view window.

Invoke the context menu and choose Properties.
Or:

Press ALT+ENTER.
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A properties dialog box appears.

The following topics are covered below:

= Normal PDS Member
= PDS Member of a Load Library

Normal PDS Member

The properties dialog box for a normal PDS member looks as follows:

§E TLINES[BRY.COMN.SOURCE] Propert -0] x|

— Datazet
t ame: BRY.COMMN.SOURCE
Yolurne: COrE10
Device pe: 3380

Oroanizatior; PO

Record format;  FE
Record length: 30
Block size: 3600

— Mermber
tame: TLIMES
WYersion: 01.34
Creation date: 1938-10-02
Last modification;  2003-03-12 10:39
Uzer 1D FHI
Iitial: 13
Size: 24

The following information is shown in this dialog box:

Group |Option Description
Box
Dataset |Name Name of the dataset which contains the member.
Volume Serial number of the volume which contains the dataset.
Device type The specified volume or the generic identifier from which a volume is to be
selected (for example, 3380).
Organization For example:
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Group  |Option Description

Box
PO PDS
PS Sequential dataset
DA Direct access

Record format  |For example:

FB Fixed block
VB Variable block
FBA Fixed block, ANSI control characters
Record length  |Record length in bytes.
Block size Block size in bytes.
Member|Name Name of the member.
Version Version number of the member.

Creation date Date in format YYYY-MM-DD when the member was created.

Last modification |Date in format YYYY-MM-DD when the member was last modified.

User ID User who last modified the member.
Initial Initial size of this version.
Size Number of lines in the member.

PDS Member of a Load Library

The properties dialog box for a PDS member of a load library looks as follows:
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[ TEMPNAME[NOM.I¥Z221.LOAD] Prop - I I:Ilil
— Datazet
M ame: HOM. 227 L0AD
W olunne: DCHO0

Device pe: 33590
Oroanizatior: PO
Record format: 1
Record length: 0
Blozk zize: E447

Linkage date:  2003-07-071

Linkage editor:  BES50DFT03 Werzion;
Z0PS: HOME

Unrezolved: HOME

— Member
M arne: TEMPHAME
Length: 1016 Hex: 000003FS
Attribute: REMT REUS RMODEAMY AMODE
Entry point: HOMCOMPR

The following information is shown in this dialog box:

Group |Option
Box

Description

Dataset |Name

Name of the dataset which contains the member.

Volume Serial number of the volume which contains the dataset.

Device type | The specified volume or the generic identifier from which a volume is to be selected

(for example, 3380).
Organization |For example:
PO PDS
PS Sequential dataset
DA Direct access
Record format |For example:
FB Fixed block
VB Variable block
FBA Fixed block, ANSI control characters

Record length |Record length in bytes.
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Group  |Option Description
Box

Block size Block size in bytes.
Member |[Name Name of the member.

Length Member's length in bytes.

Hex Member's length in bytes in hexadecimal format.

Attribute The member's attributes in keyword format. The relevant keywords are separated
by one blank. For possible values, see the description of the
MODULE-ATTRIBUTES field in the LIB-DIRECTORY view in the Entire System
Server User’s Guide.

Entry point  |Entry point of the load module.

Linkage date |Date of linkage/zap in format YYYY-MM-DD.

Linkage editor|Name of linkage/zap editor.

Version Version of linkage/zap editor.

ZAPS Displays the number of applied zaps.

Unresolved |Displays the number of unresolved external references.
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In the object workspace, the z/OS volumes are shown when you expand the Volumes folder of a
z/OS node. Example:

EI@ M ainframe M avigation
g3 05390 Nodes

=-F 148<DAEF>

. #-gm Datasets

Eﬁ Wolumes

-3 DEDCOT

=3 DEDCOZ

=3 DEDCOT

Filtering z/OS Volumes

Before displaying z/OS volumes, you can define a filter so that only those volumes are shown
which correspond to your filter criteria.

> To define a filter

1  In the object workspace, select the Volumes folder in the appropriate server node.

2 Invoke the context menu and choose Filter.
Or:
Press Fs.

The following dialog box appears:

&5 MM - Filter ¥Yolumes

M ode: 148

Walume: IH

[k | Cancel Help

|Erter valurme name:.

3  Enter the filter criteria for the volumes that are to be shown. You can use a combination of
strings and wildcards (* and _) to display the volumes matching the volume name pattern.

4  Choose the OK button.
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Listing z/OS Volumes

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/OS volumes (see Filtering z/OS Volumes).

> To list z/OS volumes

1 In the object workspace, select the Volumes folder in the appropriate node.

2  Invoke the context menu and choose List.
Or:
Press Fs.

The volumes are shown in the list view window. Example:

& COM* List Yolumes ;IEIEI

i Uu:ulumel L it | SEriesl Status | MDuntStatusl Free[E_l,II,Trks]l LargestLlnit[E_l,II,Trks]l Class | SMS |

EIICOMSI0 ¢ 0220 3380  OMLINE RESIDENT 340,0488 11,0000 DASD MO
EICOMST 0221 3380 OMLINE RESIDENT 171,0282 17.0000 DASD  NOD
EICOMS12 0222 3380 ONLINE RESIDENT 3760417 19,0000 DASD  NOD

The list contains the following columns:

Column Description
Volume Volume serial number.
Unit Unit address.
Series Device series.
Status Device status. Possible values:
CHANGE Device status is changing.
OFFLINE Device is offline.
ONLINE Device is online.
Mount Status Device mount status. Possible values:
MOUNT PEND Mount is pending.
NOT READY Device not ready.
REMOVABLE Device is removable (for example, a tape).
RESERVED Device is reserved.
RESIDENT Device is resident (for example, a hard disc).
Free (Cyl, Trks) Number of free cylinders / unused tracks.

Mainframe Navigation 99



z/0S Volumes

Column Description
Largest Unit (Cyl, Trks) |Contiguous cylinders/tracks in largest free extent.
Class Device class. Possible values:
COMM Communications.
CTCA Channel-to-channel adapter.
DASD Direct access.
DISP Display station.
TAPE Tape.
UREC Unit record.
SMS SMS-controlled device/unit. Possible values: YES, NO.

Filtering Datasets on a z/OS Volume

Before displaying datasets on a z/OS volume, you can define a filter so that only those datasets
are shown which correspond to your filter criteria.

> To define a filter

1 Select a volume in the object workspace or list view window.

2 Invoke the context menu and choose Filter Subobject.

Or:

Press CTRL+F3.

The following dialog box appears:

E% MN - Filter Subobject Datasets

M ade: 148

D atazet name; ||

Wolume: IFDBHEI#
Pazzwiord: I

[ Cancel Help

|Enter dataset name.
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3  Enter the filter criteria.

Option Description

Dataset name|The datasets that are to be shown. You can use a combination of strings and wildcards
(* and _) to display the datasets matching the dataset name pattern.

Password System password if volume is protected.

4  Choose the OK button.

Listing Datasets on a z/OS Volume

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the datasets on a z/OS volume (see Filtering Datasets on a z/OS Volume).

> To list datasets on a z/OS volume

1 Select a volume in the object workspace or list view window.

2 Invoke the context menu and choose the List command.
Or:
Press Fs.

A list of datasets contained in the catalog is shown in the list view window. Example:

olume =COMS11 List Datasets =1a x|
£ Datazet Mame Organization | Record Length | Block Size | Record Formnat | Cylinderl Trackl % Usedl Created I Last Access I SMS | Update ;I
iEl 40ASQLCOMM SPLLCOBINT - PS 00500 06500 | FBE 2 10 100 2001-08-25 2001-08-25 WO WO
§E§ 4DASOL COMM.SPLICOBINZ - PS 00500 0B500 | FE 14 1] 95 2001-08-25 2001-08-27  NO WO
fE) ADASOL COMM.SPLICOBING - PS 00080 00800 FE 0 1 100 1995-0815 2001-08-25 WO WO
fE} 4DASOL COMM.SPLICOBING — PS 00080 06240 FE 3 1] BE  1993-08-15  2001-08-25 NO WO
fEl ADASOL.COMM.SPLLCOBING - PS 0000 06240 FE 12 1] 96 1393-08-15  2000-01-24 NO WD
LEADASEL COMN.SPLLDBRMLIE PO 00080 04000  FE 0 7 28 2000-07-23 20030323 NO WO
LE4DASEL COMN.SPLILLDAD PO 00000 23030 U 36 1] 40 2000-01-18 20030715 NO WO
L ADASEL COMN.SPLILSRCE PO 00080 06240 FE 2 G 57 19930815 20030715 NO WO
LA ADASOL COMN. TEST.GEN PO 00080 03600 FE 0 9 88 1987-08-26 20030929 NO WO
L@ ADASOL COMN. TEST.SRCE PO 00080 03600 FE 12 1] 97 1988-06-06 20030909 NO WO
LA ADASOLCOMN. TRSUBSTR PO 00080 06240 FE 0 5 100 1995-09-02 20020118 WO NO
LA ADASOLTEST.SOURCE PO 0000 03600 FE 4 1] 7519980114 2003-0310  NO WD
L 45B.COMN LOAD PO 00000 23200 U 1 1] 26 1996-03-28 2003-08-25 NO WO
L 45B DAEH.JOBS PO 00080 03120 FE 0 10 40 2001-07-13  2003-03-21  NO WO
L 45E DAEH.JOBS ADADZ PO 00080 03120 FE 0 10 30 2001-07-13 20030323 NO WO
LEASBIDCA CNTL PO 00080 03120 FE 0 5 100 19930719 20030804 WO WO
L BHD DB2PTFS PO 00080 04000 FE 29 1] 97 1993-09-20 2003-05-28 NO WO
LA BHD. THOMAS PO 00080 04000 FE 1 1] 46 2002-11-06  2002-11-06  NO - WO
LA BUNKER.PROD.RESTOREJCL PO 0000 03120 FE 1 1] 53 1393-03-07 20031007 NO WD
L BWE.COMM.JCL PO 00080 04000 | FE 11 1] 42 2002-04-13 20031007 NO WO ;I

The list contains the following columns:
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Column

Description

Dataset Name

The name of the dataset.

Organization |Dataset organization, for example:
DA Direct access.
PO Partitioned dataset (PDS).
POE Partitioned dataset (PDSE).
PS Sequential dataset.

Record Length |Logical record length in bytes.

Block Size Block size in bytes.

Record Format

Record format, for example:

F Fixed length record.
FB Fixed blocked record.
FBA Fixed blocked record, ANSI control characters.
U Unformatted record.
\Y Variable record.
VB Variable blocked record.
Cylinder Size of dataset in cylinders.
Track Size of dataset in tracks.
%Used Percentage of dataset used.
Created Dataset creation date.

Last Access

Date of last access.

SMS

Is this an SMS-controlled device/unit (YES, NO)?

Update

Has the file been updated since the last backup (YES, NO)?

Displaying the Properties of a zZ/OS Volume

You can display information about a z/OS volume.

~ To display the properties of a z/OS volume

1  Select a volume in the object workspace or list view window.
2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.
A properties dialog box appears.
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&5 MM - DBDCO1 Properties Yolume !EI
—Wolume
M ame: DEDCOT
Senes; 3390
Uit 4431

Tracks per culinder: 15

Fercentage uzsed: 46

Total space: 3339 CYL H0085 TRE.
Free space: 1786 CYL + 41 TRK
Largest unit: 1781 CvL + OTRK

Free extents: 13
5kS control WO

Ok,

The following information is shown in this dialog box:

Option Description

Name Volume serial number.
Series Device series.

Unit Unit address.

Tracks per cylinder |[Number of tracks per cylinder.

Percentage used  |Percentage of disk used.

Total space Total number of cylinders on disk pack.

Free space Number of free cylinders and tracks on disk pack.
Largest unit Number of cylinders and tracks in largest free extent.
Free extents Number of free extents on disk pack.

SMS control SMS-controlled device/unit (YES, NO).
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z/0S Jobs

In the object workspace, the z/OS jobs are shown when you expand the Jobs folder of a z/OS node.
Example:

=¥ Mainframe Mavigation

g3 05390 Nodes

=[] 148<DAEF>

@ Datazets

H-Em Volumes

Elﬁ Jobsz
l'.m HCOMOTF<003037 3
'E HCOMOTF<0030438:
'E =COMOTF<0033391
'E =COMOB2<0031 461

Filtering z/OS Jobs

Before displaying z/OS jobs, you can define a filter so that only those jobs are shown which corres-
pond to your filter criteria.

> To define a filter

1  In the object workspace, select the Jobs folder in the appropriate node.
2 Invoke the context menu and choose Filter.
Or:

Press F3.

The following dialog box appears:

1 MM - Filter Jobs EE

M ode: 148

Type— | 7 Queue
Joh g I .
oh name p<LOM [~ Jab [T Executing
Class: I [ Started task [ Input

szer IO I [T TS50 user [ Output
I~ Hald

[~ waiting

Ok Cancel Help

|Enter joh narne.
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3  Enter the filter criteria.

Option Description

Job name|Job name on the job card. You can use a combination of strings and wildcards (* and _) to
display the jobs matching the job name pattern.

Class JES job class or output class.

User ID |ID of the user who submitted the job.

Type If you are only interested in a specific type of job, you can activate one or more of the
following check boxes:
Job (standard operating system job)
Started task
TSO user
When none of these check boxes is selected, all information is always shown.

Queue |If you are only interested in specific queues, you can activate up to four check boxes for the

JES queue type:

Executing Executing queue.

Input Input queue (held and non-held jobs).
Output Output queue.

Hold Output queue jobs on hold.

Waiting Input queue jobs on hold.

When none of these check boxes is selected, the information from all queues is always
shown.

4  Choose the OK button.

Listing z/OS Jobs

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/OS jobs (see Filtering z/OS Jobs).

> To list 2/0S jobs

1  In the object workspace, select the Jobs folder in the appropriate node.

2 Invoke the context menu and choose List.

Or:

Press Fs.

A list of jobs is shown in the list view window. Example:
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1 - WC0M™ List Jobs

ok Hame | Mumber | Tope | Gueus | Ciass | prioriy | Destinalion | Sl | cwrer | S2ep Procadure | GPU | Region ¥ | Records | StertDate [ Tine =
OOAgEr ETC O L] 144 LAl BAAIL  RCOMOTT 13 AT 073505
" RCoMTT AGes  STC X s HCOMOTT | WCOWDTT  WCOMOTT 5852 Tz &0 2
raL'HEDM:E] DOTED STC O X 148 LioaZal AVAIL  RCOWNDEZ 130 20074204 074518
Jxcomoez  pozmoR STC X ms MCOMDEZ 339
r".i..KL".N'L'E D2 5T 9 K 1ad LOCAL AVAIL  BCFESTC T3 20At2Y O M4l
TURCOMIDE  DOMSEE STC X 05 ALFIETS 0
IlaJ,.'*’.l'l.'.i.l'-i.‘i DIEOZ2S STC O X 184 LAl BNAL ECOW] &5 13 2007424 0T 32 26
r;‘ HOOKH 45 DOziS4s STC O K 184 LoZAL BVAIL TN &5 135 2007-41-27  Oom3gd
r"_ﬁ..KLl'.‘h'l'd':l DOiBdd ETC @ 17 L] LOCAL AVAIL OO &5 HEd 2000127 O
AwCoMIAS  DOTEE STC O ¥ 184 LAl BYRIL OO 45 135 200724 O7.e442
Y RCOMAS DOTaR STC O s 1] LAl AR, OO &5 BG4 MOT-1304 O a8 47
r‘iL.'ﬂEEM‘ 45 DOZZ34 STC X Ms HCOk 85 Hrs
TxcoMi4s  DoZABE STC X ms T &5 350
Mgucomids  0oxete STE X s MCOMIAS WCOMISS WCOMIAE  aF42 B4 D00 15106 _'j
i ] 3
The list contains the following columns:
Column Description
Job Name |Name of the job.
Number |JESjob number.
Type Type of job. Possible values:
JOB Standard operating system job.
STC Started task.
TSO TSO user.
Queue JES queue type. Possible values:
H Output queue jobs on hold.
I Input queue (held and non-held jobs).
O Output queue.
X Executing queue.
Class JES job class (when the queue type is I or X) or output class (when the queue type is O or
H).
Priority JES priority within the current queue.
Destination |JES printout destination name.
Status Job status (can be AVAIL or HOLD).
Owner ID of the user who submitted the job.
Step Name of the step currently executed (only when the job is active).
Procedure |Name of the procedure currently executed (only when the job is active).
CPU CPU time in minutes consumed by the address space (only when the job is active).
Region Amount of real storage used by the address space in Kbytes (only when the job is active).
10 Number of I/Os performed so far (only when the job is active).
Records Total number of records in job sysout files.
Start Date |Date when job execution started.
Time Time when job execution started.
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Column Description

End Date |Date when job execution ended.

Time Time when job execution ended.

System ID |System in which the job executes in a Sysplex environment.

Displaying the Condition Codes of a z/OS Job

When you display the condition codes of a job, they are shown in a browse window.

~ To display the condition codes of a z/OS job

1
2

Select a job in the object workspace or list view window.

Invoke the context menu and choose Condition Codes.
Or:
Press CTRL+ALT+C.

A browse window similar to the following appears in the content pane.

& XCOMO77 30373 > CC Browse Job O] x|
Huml Text |
1 2 FFSTARTIHG EXEC XCOWA7?y
2 4 XXXCOMB77 EXEC PGH=MPRIMIT,REGION=8H,TIHME=1448 aeeaAe17

See also Commands for Browsing an Object.

Displaying the Status of a z/OS Job

You can check whether a job is executing or whether it is in the input queue or output queue.

~ To display the status of a z/OS job

1
2

Select a job in the object workspace or list view window.

Invoke the context menu and choose Status.
Or:

Press CTRL+F10.
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The job status is displayed in a dialog box in the content pane. Example:

XCOMO77 303732 Status Job

3 Choose the OK button to close the dialog box.

Putting a z/OS Job on Hold

You can put the sysout of a job on hold.

> To put a z/OS job on hold

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Hold.

All job sysout is put on hold.

Releasing a z/0OS Job from Hold

When the sysout of a job has been put on hold, you can release it from hold.

~ To release a z/OS job from hold

1  Select a job in the object workspace or list view window.

2  Invoke the context menu and choose Release.

All job sysout is released from hold.
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Changing the Attributes of a zZ/OS Job

You can change the class and/or destination of a z/OS job.

~ To change the attributes of a z/OS job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Change.

The following dialog box appears:

J1XCOM077<23131> Chang x|

Made: 148
Job name:  ®COMOFY
Job number: 23131

Clazz: ||_
Destination; I

] | Cancel Help

|Enter job class.

3  Enter the new attributes.

4  Choose the OK button.

Turning on Follow Mode for a z/OS Job

You can instruct Mainframe Navigation to display a message when the job has terminated.

Follow mode can be active for one job only. If it is activated for a second job before the first job
has terminated, only the second job will be followed.

~ To turn on follow mode for a z/OS job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Follow.
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Turning off Follow Mode for a z/OS Job

When you turn off follow mode, a message is no longer displayed.

~ To turn off follow mode for a z/OS job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Follow Off.
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z/OS Sysout Datasets

In the object workspace, the sysout datasets are shown when you expand a job. Example:

Elﬁ Mainframe Mavigation

-G 05390 Modes
= B 148=mrz=
- Datasets
% Yolumes
E|§. Johs

FTESTS=0010595=
o JL=00001 =
- =m=00001=
—BA sm=n0002-

Listing z/OS Sysout Datasets

Different types of files are shown when you list the z/OS datasets for a job. The names of these
files start with the following characters: JC (input JCL), SI (sysin data) SM (system messages) and

SO

(sysout data).

> To list z/OS sysout datasets

1  In the object workspace, select a job in the Jobs folder.
Or:
Select a job in the list view window which shows a list of jobs.
2 Invoke the context menu and choose List.
The sysout datasets of the job are shown in the list view window. Example:
k! XCOMOT77 30456 List Sysout datasets -0 x|
i Filel Mumnber I Procedure | Step DD | Clazs I Records | Copies | Farm | FCE | "Writer | Flazh |
L 1 JESICLIN 2 2 1 STD
Hof s 1 JESZ JESMEGLG 2 2 1 5TD s s
BoA oM 2 JESZ JESJCL £ 42 1 5TD ===
Bl s 3 JESZ JESYSMSG 2 2 1 5TD ==
4 50 1 HCOMO7TY | SYSPRIMT X 0 1 5TD ==
The list contains the following columns:
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Column Description

File File type.

Number |File number.

Procedure | Procedure being executed.

Step Job step referencing the file.
DD DD name.
Class Output class.

Records |Number of records in the file.

Copies  |Number of file copies.

Form Print form.
FCB Form control buffer.
Writer External writer.

Flash Form overlay (flash).

Releasing a z/OS Sysout Dataset from Hold

You can release a single sysout dataset of a z/OS job from hold.

~ To release a z/0S sysout dataset from hold

1  Inthe object workspace, expand a job in the Jobs folder.

Or:

Invoke the list view window which shows the sysout datasets for a job.

2 Select a sysout dataset.

3  Invoke the context menu and choose Release.

The selected job sysout is released from hold.
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Changing the Attributes of a zZ/OS Sysout Dataset

You can change the class and/or destination of a z/OS sysout dataset.

~ To change the attributes of a z/OS sysout dataset

1 In the object workspace, expand a job in the Jobs folder.

Or:

Invoke the list view window which shows the sysout datasets for a job.

2 Select a z/OS sysout dataset.

3  Invoke the context menu and choose Change.

The following dialog box appears:

i BRY <370987> JL-1 Change

MNode: 148
Job name:  BRY
Job number: 32987
Sysout; JL-1

LClazs: ||_
Deztination; I

1] | Cancel

Help

|Erter job class.

4  Enter the new attributes.

5 Choose the OK button.

116

Mainframe Navigation



13 z/0S Active Jobs

B Filtering Z/OS ACHVE JODS ...t 118
B LiSting Z/OS ACHVE JODS ... 119
= |isting Sysout Datasets of @ Z/OS ACHIVE JOD .........cccuuiiiiiiiiiii e 121
= Displaying the Condition Codes 0of @ Z/OS ACtIVE JOD ........coiiiiiiiiiiiiii e 121
= Turning on Follow Mode for @ z/OS ACHVE JOD ......vvviiiiiiiiie e 122
= Turning off Follow Mode for @ Z/OS ACtVE JOD ........cooiiiiiiii e 122

"7



z/0S Active Jobs

In the object workspace, z/OS active jobs are shown when you expand the Active Jobs folder.
Example:

=¥ Mainframe Mavigation

g3 05390 Nodes

=[] 148<DAEF>

@ Datazets

H-Em Volumes

@ Jobs

Elﬁ &chive Jobs
l'.m HCOMOTF<003037 3
l'.m #COM145<0030279:
l'.m #COM148<0030293:

Filtering z/OS Active Jobs

Before displaying z/OS active jobs, you can define a filter so that only those active jobs are shown
which correspond to your filter criteria.

> To define a filter

1  In the object workspace, select the Active Jobs folder in the appropriate node.

2  Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:
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1 MM - Filter Active Jobs

M ode: 148

Job name: Im

Type
[ Job

[~ Stared Task
[T 750 uger
[ Iritiatar

[ Orly In Memany

)8

Cancel Help

|Enter job narne.

3  Enter the filter criteria.

Option Description

Job name Job name. You can use a combination of strings and wildcards (* and _) to display
the jobs matching the job name pattern.

Type If you are only interested in a specific type of job, you can activate up to three check

boxes:

Job (standard operating system job)
Started task

TSO user

Initiator (job entry system initiator)

When none of these check boxes is selected, all information is always shown.

Only in memory

Activate this check box to display only in-memory active jobs.

4 Choose the OK button.

Listing z/OS Act

ive Jobs

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/OS active jobs (see Filtering z/OS Active Jobs).

~ To list z/OS active jobs

1 In the object workspace, select the Active Jobs folder in the appropriate node.
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2 Invoke the context menu and choose List.
Or:
Press Fs.
The active jobs are shown in the list view window. Example:
XCOM* List Active Jobs =10 x|
£ Job Namel MNurnber I Class | Step Frocedurs | Type I Pos I D5k I Region | CPU | d |
‘W XCOMO77 0030456 XCOMO7?  XCOMO7?  STC M5 225 BS0 1:19.87 10
E<COM145 ¢ 0030278 xCOM145  =COM145  STC W5 223 BB88 37212 4662208
WXCOMT43 0030345 XCOM148  XCOM148  STC W5 223 B804 20007 e
“WXCOM130 0052534 xCOM180  XCOM180  STC M5 225 804 05314 2649
“W<COMTS0B 0040917 XCOM180B  XCOM180  STC M5 225 352 0:00.36 29
“WXCOMOES 0030713 ®COMOE3  QESMF321 STC M5 225 728 111400 794
The list contains the following columns:
Column Description
Job Name |Name of the job.
Number |JES job number.
Class JES2 batch initiator class(es) (JOB- or INI-type jobs only).
Step Name of the step currently being executed.
Procedure | Name of the procedure currently being executed.
Type Type of job. Possible values:
INI Job entry system initiator.
JOB Standard operating system job.
STC Started task.
TSU TSO user.
Pos IN Job is in memory.
N-S Not swappable.
ouT Job is not in memory.
DSP Dispatching priority.
Region | Amount of real storage used by address space in Kbytes.
CPU CPU time in minutes consumed by the address space.
10 Number of I/Os performed so far.
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Listing Sysout Datasets of a z/OS Active Job

Different types of files are shown when you list the sysout datasets for an active job. The names
of these files start with the following characters: JC (input JCL), SI (sysin data) SM (system messages)
and SO (sysout data).

~ To list sysout datasets of a z/OS active job

1

In the object workspace, select an active job in the Active Jobs folder.
Or:

Select an active job in the list view window which shows a list of active jobs.

Invoke the context menu and choose List.

Or:

Press Fs.

The sysout datasets of the active job are shown in the list view window.

For a description of the columns in the list view window, see Listing z/OS Sysout Datasets.

Displaying the Condition Codes of a z/OS Active Job

When you display the condition codes of a job, they are shown in a browse window.

~ To display the condition codes of a z/OS active job

1
2

Select an active job in the object workspace or list view window.

Invoke the context menu and choose Condition Codes.
Or:
Press CTRL+ALT+C.

A browse window similar to the following appears in the content pane.
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& XCOMOTT 30373 > Browse Active Job =10 x|
Huml Text
1 2 FFSTARTING EXEC XCOM@77
2 L XXXCOMe7¥ EXEC PGH=HPRIWIT,REGIOH=8H,TIME=1448 geaaaay

See also Commands for Browsing an Object.

Turning on Follow Mode for a z/OS Active Job

You can instruct Mainframe Navigation to display a message when the active job has terminated.

Follow mode can be active for one job only. If it is activated for a second job before the first job
has terminated, only the second job will be followed.

> To turn on follow mode for a z/OS active job

1  Select an active job in the object workspace or list view window.

2 Invoke the context menu and choose Follow.

Turning off Follow Mode for a z/OS Active Job

When you turn off follow mode, a message is no longer displayed.

~ To turn off follow mode for a z/OS active job

1  Select an active job in the object workspace or list view window.

2 Invoke the context menu and choose Follow Off.
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14 Support of Natural ISPF Object Exits under z/0S

Natural ISPF provides a number of user exits written in Natural (see Administration Guide > User
Exits in the Natural ISPF documentation).

Under z/OS, Mainframe Navigation supports the following Natural ISPF object exits:

ISPA---U |z/OS active jobs.
ISPC---U |Console.
ISPD---U |z/OS data sets.
ISPG---U |Syslog.

ISPJ---U  |z/OS jobs.
ISPP---U |PDS members.
ISPS---U |z/OS sysout files.
ISPZ---U |z/OS volumes.

~ To activate the ISPF object exits for Mainframe Navigation

ms  In the library SYSLIB on your mainframe, rename the module ANEXIT-X to ANEXIT-N.
There are the following differences in function codes for object exits of Mainframe Navigation:

® The data parameter #FUNCTION is enhanced by the SEND (SE) function.
" Mainframe Navigation uses the DELETE (DL) function instead of the PURGE (PG) function.

® The SUBMIT (SB) function returns the SAG Editor session number in the format SES=n or SES=nn
(where nis a one-digit and nn is a two-digit session number) in the #0PTIONS field when the
session is rebuilt on the server (see also the description of the session exit ISP--S-U).
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Known Restrictions

® The entries in Natural ISPF's configuration member CONFIG are not considered. To activate
object exits, the module ANEXIT-N and the corresponding ISPx - - - Umodules have to be available
in the library SYSLIB on your mainframe.

® The administrator must take care that no user interaction is allowed within the object exit; that
is, the modification of session parameters by object exits cannot be confirmed.

® Warnings (#ERROR-NR, #ERROR - PARM) will be displayed only if the function is forbidden
(ffERROR-CODE greater than zero).

® Options (#0PTIONS) are not supported, except for the SUBMIT function (see above).
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V Managing z/VSE Objects

This part covers the following topics:

z/VSE Files

z/VSE Sublibraries
z/VSE Members
z/VSE Volumes
z/VSE Jobs

z/VSE Active Jobs
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z/VSE Files

In the object workspace, the z/VSE files are shown when you expand the Files folder of a z/VSE
node. Example:

Elﬁ b ainframe Mawvigation
g 05390 Nodes
Eﬁ WSE Modes
=] 193<¢WSE ESA.SUPK>
=g Files
- B Cics svSTEMLOG A
CICS.5YSTEM.LOG.E
CICS.USER.JOURMAL A
CICS.USER.JOURMAL B

Filtering z/VSE Files

Before displaying z/VSE files, you can define a filter so that only those files are shown which cor-
respond to your filter criteria.

> To define a filter

1  In the object workspace, select the Files folder in the appropriate node.

2 Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:

5 Filter ¥SE Files x|

M ode: 193

Library/Drataset name: I

Wolurne: I
WSAM catalog: I
Paszword: I

] 8 Cancel Help

|Enter library or dataset name:.
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3  Enter the filter criteria.

Option

Description

Library/Dataset name

The files that are to be displayed. You can use a combination of strings and
wildcards (* and _) to display the files matching the dataset name pattern.

Volume If you do not specify a volume, only the files are listed which are currently
known to Entire System Server.
If you do specify a volume, the files contained in the specified volume are listed.

VSAM catalog Name of VSAM catalog where the library is kept. Not required if dataset is
defined in standard labels.

Password System password if the files are protected. Must be specified irrespective of

read or write protection.

4  Choose the OK button.

Listing z/VSE Files

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/VSE files (see Filtering z/VSE Files).

> To list z/VSE files

1  In the object workspace, select the Files folder in the appropriate node.

2 Invoke the context menu and choose List.

Or:

Press Fs.

The list view window appears.

The type of information contained in the list view window depends on whether or not filter
criteria for Volume have been defined (see Filtering z/VSE Files).

The following topics are covered below:

= No Volume has been specified

Mainframe Navigation
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= A Volume has been specified

No Volume has been specified

When a volume has not been specified with the Filter command, only the files are listed which
are currently known to Entire System Server. Example:

¥4 DUE* List ¥SE Files

=10l |

£ Dataset Mame

| Yolurne | Type | File M arne | Claszs I Sernes |

i=H DUEYSE PROCESS DB193.CLOG
i=H DUEVSE REVIEW.DE1592.4UT01
i=H DUEWSE REVIEW DE193.4UTO2
#=H DUEYSE REVIEW DB193 Ex) PARAMETERS

i=H DUEYSE REVIEW DE193 HISTORY

DDORFZ
DOORMA
DOORMA
DDORM
DDORF

CLOG DasD
RvUAUTT  DasDh
RvUAUTZ  DasD
RWUExF  DaSD
RWUALT  DasD

Since no volume was specified, the list of files appears as shown above with the following columns:

Column

Description

Dataset Name

Name of the file.

Volume Volume serial number.
Type Library type. Possible values:
<blank> No librarian file.
LIBR z/VSE librarian file.
File Name Library name (standard label or name generated by Entire System Server (NPRLnnn)).
Class Device class, for example:
DASD Direct access.
TAPE Tape.
Series Device series.

A Volume has been specified

When a volume has been specified with the Filter command, the files contained in the specified
volume are shown. Example:
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B3 ¥SE* Yolume =SYSWK1 List ¥SE Files =0 =|
£ Dataset Mame Relative Size | Organization | Extents | Begin End | Expiration O ate I
L WSE DUMP LIERARY 127501425 5D 1 850-0000  944-0014  2000-01-01
LEwSE HARDCOPY FILE g355/60 sD 1 B57-0000  BEO-0014  2000-01-07
LEWSE POWER ACCOUNT FILE 825090 DA 1 550-0000  B55-0014  2100-01-07
LR WSE POVER . DATA FILE E330M1520 | D& 1 4220000 543-0014  2100-01-07
Lg#vsE RECORDER, FILE g415/60 5D 1 5E1-0000 BE4-0014  2000-01-071
L WSESP.JOBMANAGER. FILE 8340415 5D 1 5560000  BSE-0014  2100-07-07

Since a volume was specified, the list of files appears as shown above with the following columns:

Column Description

Dataset Name |Name of the file.

Relative Size  |For a CKD disk: Starting block and number of blocks on which
the file resides.
For an FBA disk: Size of the file in blocks.
Organization |Dataset organization. Possible values:
DA Direct access.
SD Sequential disk.
UN Unknown or unidentified.
VS VSAM.
Extents Number of extents.
Begin Combination of "Starting cylinder head" and "block number" on which the file resides.
End Combination of "Ending cylinder head" and "block number" on which the file resides.

Expiration Date|Date on which the file will expire. Until this date is reached, each attempt to update or
delete the file will cause a console message, requiring an operator reply.

Managing Recent z/VSE Files

Mainframe Navigation internally maintains a list of the 100 files most recently accessed by the
user. This list is stored at the end of a session and is read when Mainframe Navigation is started.

The following topics are covered below:

= | isting Recent z/VSE Files
= Removing a z/VSE File from the List of Recent Files
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= Synchronizing the List of Recent Files for z/VSE Files

Listing Recent z/VSE Files

All commands that are available for files can also be invoked from the list of recent files.

> To list recently-used z/VSE files

1  In the object workspace, select the Files folder in the appropriate node.
2 Invoke the context menu and choose My Recent Files.
The list view window containing recently-used files appears in the content pane. Example:
¥% Node=193 My Recent Files ¥SE Mode 10| x|
£ Datazet Mame | Yolume | Type I W5AM Cat | Last Access |
#:BAY. TEST LIBRARY SYSwik1  LIBR 2003-03-23 11:08:40
LECICS SYSTEM.LOG & DOSRES | LIBR 2003-09-2311:08:13
H= Cla7< LOAD FILE 20030916 15:47:34
iEl DAE K USER.CATALOG 2003-03-16 15:47:38
LA DUEWSE ADABAS DEO1S.ASSORT  DAEKDZ  LIBR 2003-09-23 11:08:00
L DUEYSE ADARAS DBO1S.CLOG DAEEDZ  LIBR 2003-09-23 11:08:05
LEfsvS NEW RES SYSWwWE1  LIBR 2003-09-23 11:08:45
LEyvsE DUMP LIBRARY LIBFR 2003-09-2311:07:17
Ll vSE.POWER. QUELE FILE DOSRES  LIBR 2003-09-23 11:08:24
LE}YSE SYSRES LIBRARY LIBR 2003-09-23 11:07:45
LEvSESP.JOB MANAGER FILE SYSWwWE1  LIBR 2003-09-23 11:08:57
The list view window contains the following columns:
Column Description
Dataset Name|Name of the file.
Volume Volume serial number.
Type Library type. Possible values:
<blank> No librarian file.
LIBR z/VSE librarian file.
VSAM Cat  |Name of the VSAM catalog where the library is kept.
Last Access |Date (YYYY-MM-DD) and time the file was last accessed.
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Removing a z/VSE File from the List of Recent Files

You can remove a file from the list of recent files. This does not delete the file on the server.

~ To remove a z/VSE file from the list of recent files

1 In the list of recent files, select the dataset to be removed.

2 Invoke the context menu and choose Remove from list.
Synchronizing the List of Recent Files for z/VSE Files
You can synchronize the list of recent files with the data on the server. List entries which no longer

exist on the server (for example, because they have been renamed or deleted) are deleted from the
list of recent files.

~ To synchronize the list of recent files for z/VSE files

1  In the object workspace, select the Files folder in the appropriate node.

2 Invoke the context menu and choose Synchronize.

A dialog box appears, asking to confirm the synchronize function for the selected object.

3 Choose the Yes button to synchronize the list of recent files.

Allocating a z/VSE File

This command is generally issued for an existing file. The allocation information for the existing
item is displayed and you can overwrite the name and modify the specifications for the new item.

> To allocate a z/VSE file

1  Inthe object workspace, select a file either in the Files folder or in the z/VSE Volumes folder.

2  Invoke the context menu and choose Allocate.

The following window appears in the content pane:
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=10l x]
—W3E file
Mode: 133
Hame: WSE. AS54LIB.LIBRARY
W olurme: I—
Device wpe: I—
Organization: Iﬂ
E stent start: I—
Extent size: IEI—
Expiration date: I—
[ Cancel Help

3 Enter a new name for the file and enter or change other parameters as described in the table
below:
Option Description
Node Node containing the file.
Name File name.
Volume Serial number of the volume on which the file is to be allocated.
Device type If you do not specify a volume, specify the generic identifier from which a volume is
to be selected (for example, 3380).
Organization |Possible values:
SD Sequential disk.
SD/L Sequential disk, Librarian file.
VS VSAM.
VS/L VSAM, Librarian file.
DA Direct access.
Extent start Track number on CKD disks and block number on FBA disks on which extent is to
start. If you leave this text box blank, any free space is found and allocated.
Extent size Tracks on CKD disks and blocks on FBA disks.
Expiration date |Date when the file expires. Until this date is reached, each attempt to update or delete
the file causes a console message, requiring an operator reply.
4 Choose the OK button.
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A dialog box appears, informing you that the file was allocated at a specific track number.

5  Choose the Yes button to allocate another file.
Or:

Choose the No button to finish allocation.

Displaying the Properties of a z/VSE File

You can display information about a z/VSE file.

~ To display the properties of a z/VSE file

1 In the object workspace, select the appropriate file in the Files folder.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.

The following dialog box appears:

BT ¥SE.SYSRES.LIERARY Propetties ¥SE File - 10| x|
—5E Filz
Dratazet name: WSE SY'SRES . LIBRARY
W olurme: DOSRES
Device wpe: ECED
Organization:: IIH
Record format: 7

Record length: 1]
Block size: 1]
Allocation: A3 CyL 0 TRE
Allocated extentz: 1

Security:

Creation date: 2003-02-25
E «piration date: 31/25/93
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Filtering the Sublibraries of a z/VSE File

The following information is shown in this dialog box:

Option

Description

Dataset name

Name of the file.

Volume Serial number of the volume on which the file is allocated.
Device type If a volume is not specified, this is the generic identifier from which a volume is to
be selected (for example, 3380).
Organization Dataset organization. Possible values:
DA Direct access.
SD Sequential disk.
UN Unknown or unidentified.
VS VSAM.
Record format  |For example:
FB Fixed block.
VB Variable block.
FBA Fixed block, ANSI control characters.
Record length  |Logical record length in bytes.
Block size Block size in bytes.
Allocation Allocated cylinders and tracks.

Allocated extents

Number of extents.

Security

Security status. Possible values:

NONE Not password-protected.

READ Password-protected for read and write
operations.

WRITE Password-protected for write operations.

Creation date

File creation date in format YYYY-MM-DD.

Expiration date

Date when the file expires. Until this date is reached, each attempt to update or
delete the file causes a console message, requiring an operator reply.

See Filtering the Sublibraries of a z/VSE File in the section z/VSE Sublibraries.
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z/VSE Sublibraries

In the object workspace, the z/VSE sublibraries are shown when you expand a z/VSE file. Example:

Elﬁ Mainframe Navigation
F-[C3 05380 Nodes
E-@ VSE Nodes
=B 123<0avN=
EIE# Filez
{4 TST.NAT41.USERLIBS
4 TST.NAT42 USERLIBS
{4 TST.NAT43 USERLIBS
L} TST.NATS2 USERLIBS
g BACKUP
- JOBLIB
& LISTING
&-Jfm SCRATCH
- TMPLIB
- WRKLIB

Filtering the Sublibraries of a z/VSE File

Before displaying the sublibraries of a z/VSE file, you can define a filter so that only those files are
listed which correspond to your filter criteria.

~ To define a filter
1 In the object workspace, select the appropriate file in the Files folder.
Or:

Select a file in the list view window which shows a list of sublibraries.

2 Invoke the context menu and choose either Filter Subobject (when a file has been selected in
the Files folder) or Filter (when a file has been selected in the list view window) .

Or:
Press either CTRL+F3 (for the Filter Subobject command) or 3 (for the Filter command) .

A dialog box appears. Its name in the title bar depends on the command that has been used.
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&5 APS.DEY.LIBRARY.* Filter Sublibraries |

M ode: ey

Library/D ataset name: I.-“-‘-.F'S.D EW LIBRARY

Sub librany: I

Wolume: I
WSAM catalog: I

.

Cancel Help

|Enter sub library name.

| Note: When you have chosen the Filter Subobject command, several text boxes are

dimmed.

3  Enter the filter criteria.

Option

Description

Library/Dataset name :

The files that are to be displayed. You can use a combination of strings and
wildcards (* and _) to display the files matching the dataset name pattern.

Sublibrary

The sublibraries that are to be shown. You can use a combination of strings
and wildcards (* and _) to display the sublibraries matching the sublibrary
name pattern.

Volume "

If you do not specify a volume, only the files are listed which are currently
known to Entire System Server. If you do specify a volume, the files contained
in the specified volume are listed.

VSAM catalog

Name of the VSAM catalog where the library is kept. Not required if dataset
is defined in standard labels.

" Cannot be modified with the Filter Subobject command.
4  Choose the OK button.

Listing the Sublibraries of a z/VSE File

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the sublibraries of a z/VSE file (see Filtering the Sublibraries of a z/VSE File).

> To list the sublibraries of a z/VSE file

1 In the object workspace, select the appropriate file in the Files folder.
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2  Invoke the context menu and choose List.
Or:
Press Fs.

The sublibraries of the selected file are shown in the list view window:

¥ YSE.AS4LIB.LIBRARY.* List Su 10| x|
|~ Sublibrary I b embers |

L@ 5avE 0

(e SERVPHS g

CmssL B

CERTCPIP14 280

Cea TCPIP14F 206

L TCRIP150 357

The number of members contained in a sublibrary is listed in the Members column.

Filtering Members of a z/VSE Sublibrary

See Filtering Members of a z/VSE Sublibrary in the section z/VSE Librarian Members.

Adding a New Member to a z/VSE Sublibrary

See Adding a New z/VSE Member in the section z/VSE Librarian Members.
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In the object workspace, the z/VSE librarian members are shown when you expand a z/VSE sub-
library. Example:

Elﬁ Mainframe Navigation

Hl-Eg 05390 Nodes
E-@ VSE Nodes
=B 123<Davi=
Elﬁs Files
L TST.NAT41 USERLIBS
L TST.NAT4Z USERLIBS
L TST.NAT43 USERLIBS
L TST.NATE2 USERLIBS
-G WRKLIB
-JTE] NCIPARM.A
-fTE] NCIPARM.OBJ
-fJ&] NCIROOT.A
-] NCIROOT.OBJ
-] NCISCPCE.A
-fE] NCISCPCE.OB.
-fE] NCISTART A
-] NCISTART.OBJ

Filtering Members of a z/VSE Sublibrary

Before displaying the members of a z/VSE sublibrary, you can define a filter so that only those
members are shown which correspond to your filter criteria.

> To define a filter

1 In the object workspace, select a sublibrary of a z/VSE file.
Or:

Select a z/VSE member in the list view window which shows a list of members.

2 Invoke the context menu and choose either Filter Subobject (when a file has been selected)
or Filter (when a member has been selected).

Or:
Press either CTRL+F3 (for the Filter Subobject command) or 3 (for the Filter command).

A dialog box appears. Its name in the title bar depends on the command that has been used.
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iE Filter Librarian Members |

M ode: AEE21

Library/D ataset name: I.-“-‘-.F'S.D EW LIBRARY

Sub library: |ﬁ-‘-.F'525III

Member: ||

tember bype: I

Wolurne: I
WSAM catalog: I
Paszword: I

Scan for: I

] Cancel Help

|Erter member narne.

P Note: When you have chosen the Filter Subobject command, several text boxes are

dimmed.

3  Enter the filter criteria.

Option Description

}ibrary/Dataset name |z/VSE file which contains the sublibrary.

Sublibrary z/VSE sublibrary which contains the member.

Member The members that are to be shown. You can use a combination of strings and
wildcards (* and _) to display the members matching the member name pattern.

Member type Enter the filter criteria for a user-defined member type which has been specified
in the corresponding text box at creation time.

Volume Volume serial number (non-VSAM installations).

VSAM catalog - A name appears here only if the dataset has no label definition.

Password System password if file is protected (VSAM only).

Scan for Enter a search string contained in the member.

" Cannot be modified with the Filter Subobject command.

Choose the OK button.
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Listing Members of a z/VSE Sublibrary

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the members of a z/VSE sublibrary (see Filtering Members of a z/VSE Sublibrary).

~ To list the members of a z/VSE sublibrary

1  In the object workspace, select a sublibrary of a z/VSE file.

2  Invoke the context menu and choose List.

Or:

Press Fs.

The members of the selected sublibrary are shown in the list view window.

The type of information contained in the list view window depends on whether or not a string
has been specified with the Scan for option of the filter criteria (see Filtering Members of a
z/VSE Sublibrary).

The following topics are covered below:

= No String has been specified
= A String has been specified

No String has been specified

When a string has not been specified with the Scan for option, all columns of the list are shown.

i *.*[9YS.MEW.RES.SYSLIB] List Librarian Members

=101 x|

Member | Tupe | Created | © Modified | Blncksl Sizel W kM | Attributes H

[ CPUMWART PROC  2003-02-25 2003-02-2512:08 2 3 MSHPCTL MSHPBYP RECTYFF SYSIPT

[EJ$0CLFSU  PROC 20030225 2003-02-2510:04 2 52 RECTYFF SYvSIPT

[E]$1JCLFSU  PROC 20020225 2003-02-25 10:04 2 5E RECTYFF SYvSIPT

[E$4JCLFSU  PROC | 2003-02-25 2003-02-2510:04 1 g MSHPCTL MSHPEYP RECTYFF SYSIPT

[E]$5JCLFSU  PROC | 2003-02-25 2003-02-25 10:04 1 g8 MSHPCTL MSHPEYP RECTYFF SYSIPT

$?.JEILFSU PROC  2003-02-256 2003-02-2510:04 1 g RECTYPF SwSIPT

[E] $BJCLFSU PROC  2003-02-25 2003-02-2510:04 2 i MSHPCTL MSHPBYP RECTYPF SwSIPT

[EIDTREDVNG | Z 2003-02-25  2003-02-2510:04 2 40 MSHPCTL MSHPBYP RECTYPF

[EDTROICST | PROC 20030225  2003-02-25 10:04 1 g MSHPCTL MSHPBYP RECTYPF SYSIPT

[EIDTRICCF PROC  2003-02-25 2003-02-25 10:04 1 1 MSHPCTL MSHPEYP RECTYFF SYSIPT

[EIDTRINFOA | PROC 20030225 2003-02-2510:04 1 2 MSHPCTL MSHPEYP RECTYFF SYSIPT

[EDTRPOWR | PROC 20030225  2003-02-25 10:04 1 3 MSHPCTL MSHPEYP RECTYFF SYSIPT

[E]DTSECT=<M  PHASE  2003-02-25 2003-02-25 10:04 11 10040 MSHPCTL MSHPEYP RECTYPU AMODE31 RMODE&MY

& F5UJ0BS PROC  2003-02-25 2003-02-2510:04 1 13 RECTYFF SYSIPT

LIEDEF PROC  2003-02-256 2003-02-2510:04 1 | MSHPCTL MSHPBYP RECTYPF SwSIPT

[ELBSDL PROC  2003-02-25 2003-02-2510:04 1 1 MSHPCTL MSHPBYP RECTYPF SwSIPT j
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The following columns are provided:

Column Description

Member |Member name.

Type Member type.

Created |Date on which the member was created.

Modified |Date and time of last modification.

Blocks Number of blocks occupied by member.

Size Number of records in member.

member is edited.

VV.MM  |Version number and modification level of the current version of the member. If this field is not
blank, previous versions for this member exist, and Natural ISPF versioning is active when this

Attributes | Attributes of objects and phases.

A String has been specified

When a string has been specified with the Scan for option, only the members which contain this
string are shown in the list. For example, when the string "test" has been defined, the list is shown

as follows:

fE POt Y[ APS.DEY.LIERARY.APSZ260] Scan=tesk List Lib = ||:||E|

£ Member I Tope | Numberl First Occurence

[EIPCANSRO3 | OBJ 10 THT PCANSRO3- GETRLIMIT() Test1 Tes
FEIPCANSRO3  PHASE 3 bdfh PCANSRO3-GETRLIMIT]) Test1 Test

The following columns are provided:

Column Description

Member Name of member.

Type Member type.

Number The number of times the string occurs in the member.
First Occurrence|The first line that contains the string in the member.
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Adding a New z/VSE Member

You can add a new member to a z/VSE sublibrary.

> To add a new member

1  In the object workspace, select the appropriate sublibrary of a z/VSE file.

2 Invoke the context menu and choose New.
Or:
Press CTRL+N.

An empty new member appears in an editor window in the content pane:

B4 UNTITLED.NOTYPE[SYS.NEW.RES.SYSLIB] Mew Librarian Member = Il:llﬂ

g o

3  Enter the data for the new member.

See also Commands for Editing an Object.

4  From the Object menu, choose Save As to save your data in the editor window.

The following dialog box appears.
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fE UNTITLED.NOTYPE[¥SE.SAGLIE.LIBRARY.AD2351

M ode: 193

Library/D ataset name: I"»-"SE.S.-“-‘-.G LIB.LIBRARY

Sub library: |4D2351 ™ MSHE protect
Member: I Inline data
tember bype: I £ Yes

o) Ha

Wolurne: I 0

WSAM catalog:

—
—

Paszword:

[k,

Cancel

Help

|Enter member name.

5  Enter the following information:

Option Description

Library/Dataset |Displays the dataset name last used. You can select any other dataset by overwriting
name this name. You can also enter a library name here (standard label), which is the
name you are advised to use in direct command syntax.

Sublibrary z/VSE sublibrary.

Member Member name.

Member type Members can be grouped and listed according to a user-defined type specified in
this text box at creation time.

Volume Volume serial number (non-VSAM installations). Required only if the dataset has
no label definition.

VSAM catalog  |Required only if the dataset has no label definition (VSAM installations).

Password Enter the system password if the file is protected. Must be specified irrespective
of read or write protection (VSAM only).

MSHP protect Activate this check box to bypass MSHP protection. Otherwise, leave this check

box blank (relevant only for the Edit command).

Inline data

Relevant only for the Edit command. Choose one of the following option buttons:

Yes Indicates that the member contains SYSIPT
data.

No Indicates that the member does not contain
SYSIPT data.

Oft Switches off the SYSIPT flag for the existing

member.
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6

Choose the OK button.

Submitting a zZ/VSE Member

You can submit a z/VSE member to the operating system.

> To submit a zZ/VSE member

Select a member in the object workspace or list view window.

Invoke the context menu and choose Submit.

Or:

Press CTRL+S.

A dialog box appears, confirming that the member has been submitted.

Follow mode is automatically activated. When the job has terminated, a corresponding message
is shown.

Choose the OK button to close the dialog box.

Displaying the Properties of a z/VSE Member

You can display information about a z/VSE member.

~ To display the properties of a z/VSE member

1 Select a member in the object workspace or list view window.
2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.
A properties dialog box appears.
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i APPLID.A[SYS.NEW.RES.SYSLIB] Properties Librarian Member - |EI|E|

— Librarian Member

Libramy/Dataset name: 55 .MEW . RES
Sub libran: S'SLIE

Member: APPLID

Member bppe: A

Lazt maodification: 2003-02-25 10:01
Size: 163

The following information is shown in this dialog box:

Option Description

Library/Dataset name |Name of the library or dataset which contains the sublibrary.

Sublibrary Name of the sublibrary which contains the member.

Member Name of the member.

Member type User-defined member type which has been specified in the corresponding text

box at creation time.

Last modification Date (YYYY-MM-DD) and time of last modification.

Size Number of records in the member.
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In the object workspace, the z/VSE volumes are shown when you expand the VSE Volumes folder
of a z/VSE node. Example:

=¥ Mainframe Mavigation
F-En 05390 Nodes
Eﬁ W5E Modes
= B 193<WSE ESA SUPK:
- @@ Files
Elﬁ W5E Yolumes
=3 DDORFI
#-=3 DDORF2
[+-=3 DDORF3

Filtering z/VSE Volumes

Before displaying z/VSE volumes, you can define a filter so that only those volumes are shown
which correspond to your filter criteria.

> To define a filter

1 In the object workspace, select the VSE Volumes folder in the appropriate node.

2  Invoke the context menu and choose Filter.

The following dialog box appears:

&= Filter Yolumes x|

MHode: 193

Wolume: I"

] | Cancel Help

|Enter volume name.

3  Enter the filter criteria for the volumes that are to be shown.

4  Choose the OK button.
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Listing z/VSE Volumes

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/VSE volumes (see Filtering z/VSE Volumes).

> To list z/VSE volumes

1 In the object workspace, select the VSE Volumes folder in the appropriate node.

2  Invoke the context menu and choose List.
Or:
Press Fs.

The volumes are shown in the list view window. Example:

RI=IEY
£ Wolume | LInit | Series I Status | Mount Status |
QDDDHH AT ECKD OMLIME
=IDDORFZ | ABSY ECKD OMLIME
=IDDORFZ | AB4Y ECKD OMLIME
= DDORF4 | ABEY ECED OMLIME
=IDDORFS | ABEY ECKD OMLIME
=IDDORFE | ASY? ECKD OMLIME

The list contains the following columns:

Column Description

Volume Volume serial number

Unit Unit address.

Series Device series.

Status Device status. Possible values:
CHANGE Device status is changing.
OFFLINE Device is offline.
ONLINE Device is online.

Mount Status |Device mount status. Possible values:

MOUNT PEND  |Mount is pending.

NOT READY Device not ready.

REMOVABLE Device is removable (a tape, for example).
RESERVED Device is reserved.
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Column Description

RESIDENT IDeVice is resident (a hard disk, for example).

Filtering Files on z/VSE Volumes

Before displaying the files on a z/VSE volume, you can define a filter so that only those files are
shown which correspond to your filter criteria.

> To define a filter

1 Select a volume in the object workspace or list view window.

2 Invoke the context menu and choose Filter Subobject.

The following dialog box appears:

&5 Filter Subobject ¥SE Files X

M ode: 193

Library/D ataset name: I

Wolurne: ISYSWH
WSAM catalog: I
Pazsward: I

OF.

Cancel Help

|Enter library or dataset name.

3  Enter the filter criteria.

Option Description

Library/Dataset name | The files that are to be displayed. You can use a combination of strings and
wildcards (* and _) to display the files matching the dataset name pattern.

Password System password if volume is protected.

4  Choose the OK button.
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Listing Files on a z/VSE Volume

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the files on a z/VSE volume (see Filtering Files on z/VSE Volumes).

> To list files on a z/VSE volume

1  Select a volume in the object workspace or list view window.

2  Invoke the context menu and choose List.

Or:

Press Fs.

A list of files contained on the volume shown in the list view window. Example:

B3 * Yolume =S¥SWK1 List ¥SE Files =10 =]
£ Datazet Mame Relative Size Drganizatiu:unl E:-:tentsl Begin Enu:II E =piration Date;l
L BRY TEST LIBRARY 4515410 5D 1 3010000 301-0009  2003-06-13
LgdICCF LIBRARY 453041800 | D& 1 3020000 421-0014  2000-01-01
LE INFO.ANALYSIS. DUMP MGNT.FILE 855073 5D 1 5700000 570-0002  2003-08-25
g INFO.ANALYSIS.EXT RTNS. FILE 356541 5D 1 571-0000 571-0000  2000-01-01
LSS NEW RES 1/833 5D 1 (-00m 53-0014  2003-03-04
LgvSE. DUMP LIBR&RY 127501425 5D 1 89500000  944-0014  2000-01-01
Lgd/SE. HARDCOPY FILE 3355760 5D 1 5570000  560-0014  2000-01-01
LgdvSE POWER ACCOUNT FILE 825090 0, 1 550-0000 5550014 2100-01-0
LivSE POWER DATA FILE 633041320 D& 1 4220000 5430014 2100-01-01
L%VSE.FHEEDHDEFH.FILE 2415460 5D 1 BE1-0000  5E4-0014  2000-01-01
1

The list contains the following columns:

Column Description

Dataset Name |Name of the file.

Relative Size For a CKD disk:

Starting block and number of blocks on which

the file resides.

For an FBA disk:

Size of the file in blocks.

Organization |Dataset organization. Possible values are:

DA Direct access.

SD Sequential disk.

UN Unknown or unidentified.
VS VSAM.
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Column Description

Extents Number of extents.

Begin Combination of "Starting cylinder head" and "block number" on which the file resides.

End Combination of "Ending cylinder head" and "block number" on which the file resides.

Expiration Date|Date when the file will expire. Until this date is reached, each attempt to update or
delete the file will cause a console message, requiring an operator reply.
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In the object workspace, the z/VSE jobs are shown when you expand the Power-Jobs folder of a
z/VSE node. Example:

=] Wainframe Mavigation
% 05390 Modes
=@ SE Nodes
Bl 193¢WSE.ESA.5UP:
- ] 55521 <WSE.ESA SUPK:
--% Files
--% W5E Yolumes
Eﬁ Power-Jobs
'E MAT 310028742
! 'E MAT 3 INP< 00259525
r.m MHAT2INP< 00259526

Filtering z/VSE Jobs

Before displaying z/VSE jobs, you can define a filter so that only those jobs are shown which cor-
respond to your filter criteria.

> To define a filter

1 In the object workspace, select the Power-Jobs folder in the appropriate node.

2 Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:
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x
Mode: Ly
Job name: Ix ~ Queue — Dizposition—
B | Reader I Artive
L I ™ List [ Delete
User 10 I ™ Punch [ Hold
Dastinati [ Transmit [T Leave
tiratiorn:
Destination I F Keep
System [D: I
1] Cancel Help
|Enter job name.

3  Enter the filter criteria.

Option Description

Jobname |Job name on the job card. You can use a combination of strings and wildcards (* and _)
to display the jobs matching the job name pattern.

Class Installation-specific job class. Combinations are possible to display a list of jobs of several
classes.

User ID You can restrict the displayed jobs by specifying a user ID. You can use the asterisk (*)
as a wildcard. Only the jobs submitted by the specified user(s) are then displayed..

Destination | You can restrict the displayed jobs by specifying a destination. You can use the asterik
(*) as a wildcard. Only the jobs for the specified destination(s) are then displayed.

System ID |You can restrict the displayed jobs by specifying a system ID. You can use the asterisk
(*) as a wildcard. Only the jobs under the specified system(s) are then displayed.

Queue Job entry system queue. You can activate the check boxes for the following types of queues:

Reader
List
Punch
Transmit

Disposition |How job is handled in a Reader queue. You can activate the check boxes for the following
types of dispositions:

Active

Delete (delete after processing; job starts automatically)

Hold (hold job; must be started explicitly)

Leave (leave in queue after processing; must be started explicitly)

Keep (keep after processing; starts automatically as Delete; after run, disposition is Leave)

4  Choose the OK button.
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Listing z/VSE Jobs

The number of objects shown in the list view window depends on whether or not a filter has been

defined for the z/VSE jobs (see Filtering z/VSE Jobs).

~ To list z/VSE jobs

1 In the object workspace, select the Power-Jobs folder in the appropriate node.

2  Invoke the context menu and choose List.

Or:

Press Fs.

A list of the jobs is shown in the list view window. Example:

I°* List ¥SE Jobs

£ Job Namel Murnber I Elueuel SEgmentl Elassl Dispnsitiunl F'riu:urit_l,ll Statusl Fram I To |

R $5PL0Z23
W ADARAD
W ADABAS
W ADABAS
W ADABAS
W ADAKSP
W ADASAY
T ADASIP
W aDasIP
W aDasIP
W aDasIP
IALTER
WICATSED
1]

0030223
00e313
0023326
007763
00Z8326
00Z2696
007087
0023535
007756
0023320
0023335
0000100
0000072

L

r DD r O 13O m3Jm3arr ;o3

?

@ xIxOD MmO mom

D
L

3

I T T T T rr - oo

003
0oz
0oz
003
003
0oz
0oz
003
003
0oz
0oz
003
003

Hald

Hald
Hald
Hald
Hald
Hald
Hald
Hald
Hald

AN

Dl
Dl
Dl
kSF

EI51
EI51
El51
El51
Dl
DB

BN

EIS
El5

EI51
El51
El51

Dw/lB
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N il

| D:upiesl F'agesl Heu:u:uru:lsl Partition I CPU | IEII Step F'ru:u:eu:lurel Heginnlﬂ

—_ 1 4 4 4 1 4 4 a4

106 4365 -
| 5

0 1
s
A0 FR 04015 364454 ADARUN 0
242
144
24
15
19
el
el
el
13

Lo R S T R R T R e [ e Y s R = = O e

The list contains the following columns:

Column Description
Job Name |Job name on the job card.
Number |Job number assigned. Only the combination of job name and number uniquely identifies
a submitted job (if more than one copy of the same job is in the queues).
Queue Job entry system queue. Possible options:
L List queue.
P Punch queue.
R Reader queue.
X Transmit queue.
Segment |Number of output datasets, if segmented.
Class Installation-specific job class.
Disposition|How the job is handled in the R queue. Possible options:
* Active.
D Delete after processing (job starts automatically).
H Hold job (must be started explicitly).
K Keep after processing. Starts automatically as D.
After the run, the disposition is L.
L Leave in queue after processing (must be started
explicitly).
Priority Job priority.
Status Job status.
From Owner of the job, that is, the user who issued Submit.
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Column Description

To Destination of job.

Copies Number of copies of the job.

Pages Number of pages of the job.

Records  |Number of records of the job.

Partition Partition ID.

CrU CPU time consumed in minutes.
(@) Number of I/O operations performed so far.
Step Name of step currently being executed.

Procedure |Name of procedure currently being executed.

Region Real storage used by address space in Kbytes.

Displaying the Condition Codes of a z/VSE Job

When you display the condition codes of a job, they are shown in a browse window.

> To display the condition codes of a z/VSE job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Condition Codes.
Or:
Press CTRL+ALT+C.

A browse window similar to the following appears in the content pane:

AARISTIGD 28> Browse VSE Jab =100 %]
Hum | Text |
1 /F EXEC PROC-ARISTZSL w-- DEZ PRODUCTION LIBRARY ID PROC LTI
2 15461 OME STATEMENT SKIPPED DUE TO IF CONDITION
a /4 EXREC PROC=ARISTZDB «—— DBEZ DATABASE 1D PROC BARBSBAR
£f EREC  ARISOLDS ,SIZE=AUTOD,PARH="RHTUSERS=1@" LT

5 155l PHASE RAISOLDS IS5 TO BE FETCHED FROM PRDZ.DB2720
6 15551 LAST RETURH CODE WA%S DoOA
7 EDJ ARISTZGD MAXK.RETURH CODE-DAQ0 DATE 052372003, CLOCK 21732543, DURATION 224750731

See also Commands for Browsing an Object.
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Displaying the Status of a z/VSE Job

You can check whether a job is executing or whether it is in one of the following queues: reader
queue, list queue, punch queue or transmit queue.

~ To display the status of a z/VSE job

1  Select a job in the object workspace or list view window.

2  Invoke the context menu and choose Status.
Or:
Press CTRL+F10.

The job status is displayed in a dialog box in the content pane. Example:

ADDINFO-216596= Status ¥SE

3  Choose the OK button to close the dialog box.

Putting a z/VSE Job on Hold

You can put a job on hold.

~ To put a z/VSE job on hold

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Hold.

The job is put on hold.
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Releasing a z/VSE Job from Hold

When a job has been put on hold, you can release it from hold.

~ To release a z/VSE job from hold

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Release.

The job is released from hold.

Changing the Attributes of a z/VSE Job

You can change, for example, the class and/or destination of a z/VSE job.

> To change attributes of a z/VSE job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Change.

The following dialog box appears:

fIDITEEIS1<18382> Change x|

Mode: 11
Job name:  DITEEIST
Job number; 18382

Clazs: I_

Dizposzition: Im
Fricrity: I_

Copies: I—
Destination; I—

] | Cancel Help

|Erter job class.
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3  Enter the new attributes.

4  Choose the OK button.

Turning on Follow Mode for a z/VSE Job

You can instruct Mainframe Navigation to display a message when the job has terminated.

Follow mode can be active for one job only. If it is activated for a second job before the first job
has terminated, only the second job will be followed.

~ To turn on follow mode for a z/VSE job

1  Select ajob in the object workspace or list view window.

2 Invoke the context menu and choose Follow.

Turning off Follow Mode for a z/VSE Job

When you turn off follow mode, a message is no longer displayed.

~ To turn off follow mode for a z/VSE job

1  Select a job in the object workspace or list view window.

2  Invoke the context menu and choose Follow Off.
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In the object workspace, the z/VSE active jobs are shown when you expand the VSE Active Jobs
folder of a z/VSE node. Example:

=¥ Mainframe Mavigation
F-En 05390 Nodes
Eﬁ W5E Modes
& ] 193¢WSE ESA SUPK:
= B 55521 /SE ESA S UPK:
- Files
#-Em WSE Yolumes
-z PowerJobs
Eﬁ. WSE Active Jobs
- R NPRZ20E<00X 570
LR NPR3255X<0031922:

Filtering z/VSE Active Jobs

Before displaying z/VSE active jobs, you can define a filter so that only those active jobs are shown
which correspond to your filter criteria.

> To define a filter

1 In the object workspace, select the VSE Active Jobs folder in the appropriate node.

2 Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:

1 MM - Filter ¥SE Active Jobs

M ade: RRRZE

Job name: Iﬁ

[IF | Cancel Help

|Erter job name.

3  Enter the active jobs that are to be shown. You can use a combination of strings and wildcards
(* and _) to display the jobs matching the job name pattern.

4  Choose the OK button.
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Listing z/VSE Active Jobs

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the z/VSE active jobs (see Filtering z/VSE Active Jobs).

~ To list z/VSE active jobs

1 In the object workspace, select the VSE Active Jobs folder in the appropriate node.

2  Invoke the context menu and choose List.
Or:
Press Fs.

The active jobs are shown in the list view window. Example:

_ioix

£ Jab Namel MHumber I F'artilionl Elassesl Step | Procedurs | F'riorityl Sizel Real Storage | CPU TimeI IEI| Reply D I
" ADABAS 0028826  F& HEx ADARUN g 4050 0 11685 EEB402
"{CICSICCF 0030321 F2 L2 DFHSIP 5 51200 0 1:2373 143730
"HCOMPLETE | 0030240 FE M TLINSP 3 40360 0 00560 2275 097
"HDE2START 0028838  Fa 5 ARISOLDS 13 40360 0 00138 5382
HDELACC nonozer O C JOEL 16 4932 0 0:00.00 139
"HGEFIISTA 0028817 2 C MNATGBPMG 16 4532 0 000 422
"GBP41STA | 0028818 C3 C NaTGEP4T 16 4332 0 000ts 530
ANDVIIAPS | 0030334 R R TLINSP 15 71862 0 0:03.05 2484 143
"NDV214PS | 003033F A2 R TLINSP 15 71552 0 00304 2333 182
HUNETWORK | 0030219 F9 (1= ADARUN 12 40360 0 00395 1054
rﬂNDNAME BG &0l 14 10240 0 0:00.00 4
MO NAME Fa P 11 35840 0 0:00.00 4
TEI O NAME F4 J4% 7 51200 0 0:00.00 4
"IMNPRZ2QE | 00570 1 ks NPRIMIT 171z 0 0:00.EE £ge2
"HNPRIZER: 0031922 .4 C NPRINIT 16 45932 0 00327 3289 052
POWSTART F1 IPWPIWER | POWSTRTF 1 B4 0 0487E 162924

"l SECSERY FB BSTPSTS $BJCLWMZ 4 40360 0 00007 534

" TCRIP noz2asz4 M P IPMET 3 20352 0 10230 BSE328 087
WWTAMSTRT 0028823 F3 ] ISTINCYT 2 B4 0 01633 227731
"l<C0M123 | 0030332 FF N7 NPRIMIT 10 | 40360 0 ooz 14020

The list contains the following columns:
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Column Description

Job Name |Job name on the job card.

Number Job number assigned.

Partition Partition number (ID).

Classes Job class(es) serviced by this partition under the control of z/VSE/POWER.

Step Name of the step currently being executed.

Procedure |Name of the procedure currently being executed.

Priority Dispatching priority.

Size Partition size in Kbytes.

Real Storage | Amount of real storage allocated by z/VSE to the partition in Kbytes.

CPU Time |CPU time consumed by address space in minutes.

10 Number of I/O operations performed so far.

Reply ID Outstanding operator reply ID associated with the job.

Turning on Follow Mode for a z/VSE Active Job

You can instruct Mainframe Navigation to display a message when the job has terminated.

Follow mode can be active for one job only. If it is activated for a second job before the first job

has terminated, only the second job will be followed.

~ To turn on follow mode for a z/VSE active job

1 Select an active job in the object workspace or list view window.

2 Invoke the context menu and choose Follow.

Turning off Follow Mode for a z/VSE Active Job

When you turn off follow mode, a message is no longer displayed.

~ To turn off follow mode for a z/VSE active job

1 Select an active job in the object workspace or list view window.

2  Invoke the context menu and choose Follow Off.
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VI Managing BS2000 Objects

This part covers the following topics:

OSD Files

LMS Elements

LMS Element Versions
BS2000 Jobs

BS2000 Job Variables
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OSD Files

In the object workspace, the OSD files are shown when you expand the OSD Files folder of an
OSD node. Example:

=¥ Mainframe Mavigation
F-Em 05390 Nodes
@@ VSE Nodes
Eﬁ 050 Wodes
=[] 194<B52000:

: oy

MAT:3DC1 WO TEST.GANS MEU
: MAT:3DC1 WO TEST.SEQCOPZ
=) MAT:$DC1.W0. TEST. SEQCORPY

Filtering OSD Files

Before displaying OSD files, you can define a filter so that only those files are shown which corres-
pond to your filter criteria.

> To define a filter

1  In the object workspace, select the OSD Files folder in the appropriate node.

2  Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:
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¥ Filter DSD Files

MNode: 194
File name: I
Wolurne: I—
Paszword: I—
— Options
Suppart type: m = FIQ_E! t:i; T IFES;ﬂnrdd Securityd—
ead passwor
Shared file: |<I:u:|th> vI [~ 154M I “white password
Access type: Im [~ PaM [ Exec pazsword
EGGs only m [~ Maone [~ Mone
Unclozed only: Mo
Bange keyword: |<I:ulank> j
Range walue: I
[F Cancel Help

|Enter file narne.

3 Enter the filter criteria.

Option Description

File name |The files that are to be displayed. You can use a combination of strings and wildcards (*
and _) to display the files matching the dataset name pattern.

Volume | Volume serial number. Usually not needed, unless you want to restrict a list of files to
those on a specific volume.

Password |System password, if the file is protected. Must be specified irrespective of read or write
protection.

Support  |Selects BS2000 files that reside on a specific storage medium. Possible values:

type <blank> All kinds of files, including tape files.
Public Files on public disks.
Private disk Files on private disks.
Any disk Files residing on any kind of disk.
Tape Tape files.

Shared file | Possible values:
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Option Description

<both> Lists both shared and non-shared files.

Yes Restricts list to shared (public) files.

No Restricts list to non-shared files.

Access Selects BS2000 files that are, or are not, protected against modification. Possible values:
type <blank> Both protected and non-protected files.

Read Protected files only.

Write Non-protected files only.

FGGs only |Selects only file generation groups and the related individual generations. Possible values:

Yes, No.

Unclosed |Selects only files that were opened for output (write, extend or update) and that have not
only yet been closed. Possible values: Yes, No.

Range Selects files according to the following characteristics. These cannot be combined:
keyword [ pjank> No selection is made.

Free size Files with a number of unused PAM pages within
the specified range.

Creation date Files created (or updated) in the period specified in
the range field.

Last access Files last accessed in the period specified in the range
field.

Extents Files with an extent count value corresponding to
the specified range.

Size Files with space allocation (number of PAM pages)
corresponding to the given value or range of values.

Expiration date Files with an expiration date corresponding to the
specified time range.

Backup class Backup class option: selects files with a backup
frequency attribute that corresponds to the specified
value or list of values. Each value must be a character
A,B,C,DorE.

Range Use this field to specify:
value

® arange of numbers or dates (i.e. a time period), or

® a single value or a list of values.

The format of this specification depends on the option selected in the Range keyword

drop-down list box and is identical to the notation used with a BS2000 FSTATUS command.

The only exception is that a range can be given either in the notation (start-viend-v) or as

(start-v:end-v), that is, both a comma and a colon are accepted as separators.

FCB type |Selects B52000 files that correspond to one or more file organization attributes. Attributes
can be combined. Possible values: SAM, ISAM, PAM, None.
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Option Description

security  |values:

Password |Selects only files that are, or are not, password protected. Options can be combined. Possible

Read password

Files protected against unauthorized read access.

Write password

Files protected against unauthorized modification.

Exec password

Files protected against unauthorized execution.

None

Files without any kind of password protection.

4  Choose the OK button.

Listing OSD Files

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the OSD files (see Filtering OSD Files).

> To list OSD files

1  In the object workspace, select the OSD Files folder in the appropriate node.

2 Invoke the context menu and choose List.

Or:

Press Fs.

A list of files contained in the folder is shown in the list view window. Example:
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¥F: JW0.* List OSD Files =10 |
! Fils Name PM Pages | =
Lgf:NAT-$DC1 w0 LIB 0000048
LEy:MAT:$DC1 w0 LIBT 0000024

LB :NAT:$DC1 w0 LIBA 0000024
LE:MAT:$DC1 w0 LIBE 0000024
LE:MAT:$DC1 w0 LIBC 0000024
LE:MAT:$DC1 W 0.LIBD 0000024

LB -MAT:$DC1 w0 LIBNA4 0000048
LE:MAT:$DC1 w0 LIBMEL 0000048

LE - MAT:$DC1 JwiO . LIE 0000030

LB MAT:$DC1 w0 LI 0000048

L MAT:$DCT SO LIES ooonn4s =
L MAT:$DCT SO LIES) 0000048

Bl -MAT:$DCT w0 MELLKOPIEZ 0000m 2

B=H :MAT-$DCT W 0.NELLKOPIES 0ooom 2

=l -MAT:$DCT W0 MELLKOPIERT oooom 2

Bl :MAT:$DCT JWw0 . MELL KOPIEX3 0000m 2

Bl -MAT:$DCT W0 MELL KOPIEXA 000am 2

B=4 :MAT:$DCT W0 MEU KOPIEXS 0ooom 2

BEl :MAT:$DCT W0 MEL KOPIEXE oooom 2

Bl -MAT:$DCT S0 MEL YOMISPF 0000m 2

BEH MAT: D01 SWONELT 2vYY 00o0m 2

BEl -MAT: $DCT.W0MELZ 0ooam 2

Bl -MAT $DCT Jw0 MEL2A, 00oam 2

Bl -MAT:$DCT w0 MEUZE 0000003

BEl :MaAT:$DCT W0 NELZE 0000003

Bl -MAT:$DCT.JW0.MELS 0000024

Bl -MAT:$DCT Jw0.MEUAC 0000024

Bl -MaT $DC1 w0 NEU3CE ononoza =

The list contains the following columns:

Column Description

File Name |[Full path name including catalog ID and user ID specification.

PAM Pages |[Number of disc pages allocated for the file.
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Managing Recent OSD Files

Mainframe Navigation internally maintains a list of the 100 files most recently accessed by the
user. This list is stored at the end of a session and is read when Mainframe Navigation is started.

The following topics are covered below:

= Listing Recent OSD Files

= Removing an OSD File from the List of Recent Files

= Synchronizing the List of Recent Files for OSD Files
Listing Recent OSD Files

All commands that are available for files can also be invoked from the list of recent files.

~ To list recently-used OSD files

1 In the object workspace, select the OSD Files folder in the appropriate node.

2 Invoke the context menu and choose My Recent Files.

The list view window containing recently-used files appears in the content pane. Example:

#5: Node=194 My Recent Files O -10] x|

£ Filz Hame Last Access 1=
MAT:$DC1.09892. ETE.OFK. 2003-09-1517.05: 45
HEH HAT: D01 ADADEI ASSO 2003-09-1517:06:15
@ MAT:F0C1 . ADADED, CHY 2003-09-15 170820
HEH MAT: 3001 ADADEI.SORT 2003-03-1517.08:30

HEH MAT$DC1 ADALME PARKMS  2003-03151707:13 —

HEH:N.&T::’,GDE'I.EHY.TESTD'I 2003-09-16 14:13:07
HEH:N.&T:SSDE'I.EHY.TESTLMSE-‘-‘-. 20030917 152:31:03
Lﬂ:N.ﬁ.TEDE'I Jwf0LIB 20030917 14:17:18
Lﬂ MWAT:$0CT.WOLIBT 20030917 141722
Lﬂ MAT:$DCT w0 LIBA 20030917 14:17:26
Lﬂ MAT:$DC1 w0 LIBB 20030917 14:17:23
Lﬂ MAT:$DC1 w0 LIBC 20030917 141732
Lﬂ HWAT: 00 . OLIBD 20030917 141734 =
4| | »

The list view window contains the following columns:
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Column Description

File Name |Full path name including catalog ID and user ID specification.

Last Access|Date (YYYY-MM-DD) and time the file was last accessed.

Removing an OSD File from the List of Recent Files

You can remove a file from the list of recent files. This does not delete the file on the server.

> To remove an OSD file from the list of recent files

1  In the list of recent files, select the file to be removed.

2 Invoke the context menu and choose Remove from list.
Synchronizing the List of Recent Files for OSD Files
You can synchronize the list of recent files with the data on the server. List entries which no longer

exist on the server (for example, because they have been renamed or deleted) are deleted from the
list of recent files.

~ To synchronize the list of recent files for OSD files

1  Inthe object workspace, select the OSD Files folder in the appropriate node.

2 Invoke the context menu and choose Synchronize.

A dialog box appears, asking to confirm the synchronize function for the selected object.

3 Choose the Yes button to synchronize the list of recent files.

Allocating an OSD File

This command is generally issued for an existing file. The allocation information for the existing
item is displayed and you can overwrite the name and modify the specifications for the new item.

> To allocate an OSD file

1  Select the appropriate file in the OSD Files folder of the appropriate node.

2  Invoke the context menu and choose Allocate.

The following window appears in the content pane:
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#5 Allocate 0SD File =10 x|
— 05D File
Mode: 134
Marmne: L0 TESTLIS 24
Organizatian: IF'L.-'l'-.M "I — Access rights
Becord format; INEINE Shared file: Mo =
Fecord length: IEI Access ype: WRITE
Block, size: |2III4E Faszword security: MOMNE
— Space allocation
Allocation type: P —15AM files
Prirmary quantity: |48 E.en length: IIII
Secondary quartity: |4E F.ey start: IIJ
] | Cancel Help

3  Enter a new file name and enter or change other parameters as described in the table below:

Option Description
Name Enter a new file name.
Organization|Select an FCBTYPE. Possible values: SAM, ISAM, PAM, PLAM.
Record For example:
format FB Fixed block.
VB Variable block.
FBA Fixed block, ANSI control characters.
Record Enter logical record length in bytes.
length
Block size  |Enter block size in bytes.
Space Allocation type Possible values: SAM, ISAM, PAM, None.
allocation (output field)
Primary quantity |Initial space to be reserved for the file, in PAM pages.
Secondary quantity | Additional space, in PAM pages, to be allocated, if the file fills up.
Specify a value in the range of 0 - 32767. The value 0 (zero) means
that the file will not be extended dynamically.

Mainframe Navigation

181



OSD Files

Option Description
Access rights |Security settings. Possible values:
Shared file Yes File is accessible to other users.
No Other users are prevented from
accessing the file.
Access type (output | READ Protected files only.
field) WRITE Non-protected files only.
Password security |READ Files protected against unauthorized
(output field) read access.
WRITE Files protected against unauthorized
modification.
EXEC Files protected against unauthorized
execution.
NONE Files without any kind of password
protection.
R/E Files protected against unauthorized
read and execute operations.
R/W Files protected against unauthorized
read and write operations.
R/W/E Files protected against unauthorized
read, write and execute operations.
W/E Files protected against unauthorized
write and execute operations.
ISAM files  |These parameters are available only when Organization=ISAM.
Key length (output |Key length for ISAM files.
field)
Key start (output  |Position of the first byte of the key within a record.
field)

4  Choose the OK button.

A dialog box appears, informing you that the file was successfully allocated.

5  Choose the Yes button to allocate another file.

Or:

Choose the No button to finish allocation.
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Adding a New OSD File

You can add a new OSD file to an OSD node.

> To add a new OSD file

1  In the object workspace, select the OSD Files folder in the appropriate node.

2  Invoke the context menu and choose New.
Or:
Press CTRL+N.

An empty new file appears in an editor window in the content pane:

=101.x]

| -

o of

3  Enter the data for the new member.

See also Commands for Editing an Object.

4 From the Object menu, choose Save As to save your data in the editor window.
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The following dialog box appears.

#3: New DSD File X
Mode; 194
File narne: I

Paszword: I

[ Cancel Help

|Eriter file marne.

5  Enter the following information:

Option Description

File name | A name for the new file.

Password |Optional. Enter a password if the new file is to be password-protected.

6  Choose the OK button.

Submitting an OSD File

You can submit an OSD file to the operating system.
~ To submit an OSD file

1 Select a file in the object workspace or list view window.
2 Invoke the context menu and choose Submit.

Or:

Press CTRL+S.

A dialog box appears, confirming that the file has been submitted.

Follow mode is automatically activated. When the job has terminated, a corresponding message
is shown.

3 Choose the OK button to close the dialog box.
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Changing the Attributes of an OSD File

You can change the attributes of an OSD file, for example, you can define a password.

~ To change the attributes of an OSD file

1  Select a file in the object workspace or list view window.

2 Invoke the context menu and choose Change.

The following dialog box appears:

B :NAT:$DC1.MAT228.INPL Change DSD File

— 05D File
Mame: MWAT:$DCT.MATZ228.1MPL

— Securty
Shared file:

Access bype: Winite
Retention period:

Backup type: 0

J 18

Bead pazswaord

"B
[ wirite password
r

Exec paszword

Hew pazzword: I LConfirmatian: I

Mew pazzword: I Caonfirmatian: I
Mew pagzwond: I Confirrnatior; I

]

Cancel

Help

|Select shared file.

3  Enter the new attributes.
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Option Description
Shared file |Yes Restricts the list to shared (public) files.
No Restricts the list to non-shared files.

Access type |Selects BS2000 files that are, or are not, protected against modification. Possible values:

Read Protected files only.

Write Non-protected files only.
Retention |The retention period in days during which the file can neither be modified nor deleted.
period
Backup type Saved with every ARCHIVE run (default).

Saved with runs for level B, C and D.

Saved with runs for level D.

A
B
C Saved with runs for level C and D.
D
E

Not automatically saved.

(Passwords) | To change or add a password, activate the check box for the corresponding password.
You can then modify the password text box. Enter the new password and confirm it in
the corresponding text box. For a later reset of password protection, leave the check box
empty or enter blanks in the new password field.

Read password Files protected against unauthorized read access.
Write password Files protected against unauthorized modification.
Exec password Files protected against unauthorized execution.

4  Choose the OK button.

Displaying the Properties of an OSD File

You can display information about an OSD file.

~ To display the properties of an OSD file

1 In the object workspace, select a file in the OSD Files folder.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.

The following dialog box appears:
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B :NAT:$DC1.0W0.TESTLMS2A Properties 05D File

— 05D File

=10l |

Marne;
Yiolurme:
Device wpe:
Organization:
Record format:
Record length:

Block zize:

Allocation type:
Secondary zpace:

B ackup type:

Last modification:
Creation date:
Last reference:

E «piration date:

MNAT:$DCT WO TESTLMS 28
MNAT.03

NOME

PLAM

NOME

1]

2048

Pab
43
A

2003-03-03 09: 25:51
200308119
20030917
2003-08-22

— Current allocation
Allocated pages: 48
|lzed pages: 28
Mumber of extents: 2

Fercentage uzed: 53

— Security
Shared file: 1]
Accezs hppe: WRITE
Pazzword security: NOME

—154M files
K.ey length: 0
K.y stark: ]

The following information is shown in this dialog box:

selected (e.g. D3480).

Option Description

Name File name.

Volume Serial number of the volume on which the file is allocated.

Device type |If a volume is not specified, this is the generic identifier from which a volume is to be

Organization |[FCBTYPE.

Record format|For example:

FB Fixed block.
VB Variable block.
FBA Fixed block, ANSI control characters.

Record length |Logical record length in bytes.

Block size Block size in bytes.

Allocation Possible values: SAM, ISAM, PAM, None.

type

Secondary Additional space, in PAM pages, to be allocated, if the file fills up: value in the range
space of 0 - 32767. The value 0 (zero) means that the file will not be extended dynamically.
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Option Description
Backup type |A Saved with every ARCHIVE run (default).
B Saved with runs for level B, C and D.
C Saved with runs for level C and D.
D Saved with runs for level D.
E Not automatically saved.
Last Date (YYYY-MM-DD) and time the file was last modified or renamed.
modification

Creation date

File creation date in format YYYY-MM-DD.

Last reference

Date of last access in format YYYY-MM-DD.

Expiration  |Date when the file expires (YYYY-MM-DD). Until this date is reached, each attempt
date to update or delete the file causes a console message, requiring an operator reply.
Current Allocated pages Number of PAM pages allocated for this file.
allocation Used pages Number of PAM pages used by this file.
Number of extents |Values can be from 1 to 255.
Percentage used Percentage of file used.
Security Security status. Possible values:
Shared file YES File is accessible to other users.
NO File is not accessible to other users.
Access type READ Protected files only.
WRITE Non-protected files only.
Password security |READ Files protected against unauthorized
read access.
WRITE Files protected against unauthorized
modification.
EXEC Files protected against unauthorized
execution.
NONE Files without any kind of password
protection.
R/E Files protected against unauthorized
read and execute operations.
R/W Files protected against unauthorized
read and write operations.
R/W/E Files protected against unauthorized
read, write and execute operations.
W/E Files protected against unauthorized
write and execute operations.
ISAM files Key length Key length for ISAM files.
Key start Position of the first byte of the key within a record.

188

Mainframe Navigation




OSD Files

Filtering LMS Elements of an OSD File

See Filtering LMS Elements in the section LMS Elements.
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In the object workspace, the LMS elements are shown when you expand an OSD file.

Filtering LMS Elements

Before displaying LMS elements, you can define a filter so that only those elements are shown
which correspond to your filter criteria.

~ To define a filter
1 Inthe object workspace, select the appropriate file in the OSD Files folder.
Or:

Select an LMS element in the list view window which shows a list of LMS elements.

2 Invoke the context menu and choose either Filter Subobject (when a file has been selected in
the OSD Files folder) or Filter (when an element has been selected in the list view window).

Or:
Press either CTRL+F3 (for the Filter Subobject command) or 3 (for the Filter command).

A dialog box appears. Its name in the title bar depends on the command that has been used.

I *[:NAT:$DC1.NATZ28.MAC] Filter LMS Element X|
MNode; 194
— Type
File name: I:N.-“-‘-.T:$DE'I MATZ23.MaAC
[T 5 - Source program
Element; I [T P - Protocol data
Ut I [T M - Azzembler macro
[T D-Textdata
F'EISSﬂEI[IjZ I I_ J BS2000 |I:I|:I
Scan for: I [T ¥ - General data
[” H - Compiler result
[T R - Object moduls
[T L-Load madule

[} Cancel Help

|Enter file marne.
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) Note: When you have chosen the Filter Subobject command, the File name text box

is dimmed.

3  Enter the filter criteria.

Option Description

File name " | The name of the current OSD file is shown. You can specify a different name to select a
different file.

Element |Enter filter criteria for the element. If more than one version exists for an element, the
highest version is listed.

Version  |Enter filter criteria for a previous element version. Default is the highest version.

Password |Enter the system password, if the library or element is protected. Must be specified
irrespective of read or write protection.

Scan for |When you specify a character string, only the elements containing this string will be shown.

Type Select one or more types for the elements to be listed.

Source program.

Protocol area.

Assembler macro.

Text data.
BS2000 job.

General data.

Compiler result.

Object module.

EIFRIEEFIEREEE

Load module.

" Cannot be modified with the Filter Subobject command.

4  Choose the OK button.

Listing LMS Elements

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the LMS elements (see Filtering LMS Elements).

> To list LMS elements

1  In the object workspace, select the appropriate file in the OSD Files folder.

2  Invoke the context menu and choose List.

Or:
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Press Fs.

The type of information contained in the list view window depends on whether or not a string
has been specified with the Scan for option of the filter criteria (see Filtering LMS Elements).

The following topics are covered below:

= No String has been specified
= A String has been specified

No String has been specified

When a string has not been specified with the Scan for option, all columns of the list are shown.

FE *[:NAT:$DC1.JW0.TESTLMS2A] List LMS Element =0 |
i Element Mame | Tope | Storage Mode I Yerzion Count I High Yerzsion I Created tModified |
[EIANATPARM 5 W 1 & 2003-05-03  2003-03-03 0325
AMTOM 5 W 1 (= 20030819 2003-08-19714:40
JALLES 5 W +2 W2 2000-11-01 | 2003-08-25 12:34
JCOPY 5 W +3 (= 2003-07-24  2003-07-24 11:35
JCOFv4 5 W 1 & 2003-07-24  2003-07-24 11:36
JMEU 5 W 1 (= 2003-07-23  2003-07-2315:30
JHEL 5 W 1 = 2003-07-23  2003-07-23 15:33
JMELIGA, 5 W 1 (= 2003-08-23  2003-08-23 1518
JWFEST 5 W 1 (= 2002-05-04  2002-03-04 10:05

The following columns are provided:

Column Description

Element Name|If more than one version exists for an element, the highest version is listed.

Type Type of element.
Storage Mode |Possible values:
D Delta.
\Y% Full version.

Version Count |Number of versions for the element.

High Version |Highest version encountered.
Created Creation date of highest version in format YYYY-MM-DD.
Modified Date (YYYY-MM-DD) and time the highest version was last modified or renamed.
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A String has been specified

When a string has been specified with the Scan for option, only the elements which contain this
string are shown in the list. For example, when the string "missing" has been defined, the list is
shown as follows:

fE NT*[:NAT:$DC1.NATZ28.MALC] Scan=missing List LMS Element =101 x|
i ElementNamel Type I Humber I First Record |
[EINTALIAS | M 1 MMOTE 12,PARAMETER MISSING'

NTEE M 1 .ERRT MHOTE 8'DESTIMNATION MISSIMG!

NTD‘JEE b 2 .ERR1 MHOTE 8.'TERMINAL TYPE SPECIFICATION MISSIMN
NTEHMSG b4 1 MHOTE 12, TERMIMNATION RETURMN CODE MISSING'

HTPHM M 2 .PFRINTE MMHOTE 8.'MAxIMUM PRIMTER MNUMBER MISSIHNG FOR

The following columns are provided:

Column Description

Element Name [ The name of the element.

Type Type of element.

Number The number of times the string occurs in the element.

First Record  |The first line that contains the string in the element.

Adding a New LMS Element

You can add a new LMS element to an OSD file.

> To add a new LMS element

1  Select an LMS element in the list view window which shows a list of LMS elements, or in the
object workspace.

2  Invoke the context menu and choose New.
Or:
Press CTRL+N.

An empty new element appears in an editor window in the content pane:
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§B UNTITLED[:NAT:$DC1.BRY.TESTLMS2A] New LMS Element o [w] 4]

i o

3  Enter the data for the new element.

See also Commands for Editing an Object.

4 From the Object menu, choose Save As to save your data in the editor window.

The following dialog box appears.

fE UNTITLED[:NAT:$DC1.BRY.TESTLMS2A] New LMS Element x|

Made: 194

File rarne: I:NﬁT:$DE1.EHY.TESTLM52&

Element; I

Type: |5 -Source progiam ¥ |

Werzion: I

Paszword: I

[ Cancel Help

|Enter element name.

5  Enter the following information:

196 Mainframe Navigation



LMS Elements

Option Description

File name |Displays the file name last used. You can select any other file by typing over this name.

Element |Name for the new LMS element.

Type Select one of the following types:

Source program.

Protocol area.

Assembler macro.

S

P

M

D Text data.
] BS2000 job.
X

H

R

L

General data.

Compiler result.

Object module.

Load module.

Version |Optional. A version name for the LMS element.

Password |Optional. Enter a password if the new LMS element is to be password-protected.

6  Choose the OK button.

Submitting an LMS Element

You can submit an LMS element to the operating system.

> To submit an LMS element

1  Select an LMS element in the object workspace or list view window.

2 Invoke the context menu and choose Submit.
Or:
Press CTRL+sS.
A dialog box appears, confirming that the element has been submitted.

Follow mode is automatically activated. When the job has terminated, a corresponding message
is shown.

3 Choose the OK button to close the dialog box.
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In the object workspace, the LMS element versions are shown when you expand an element which
has more than one version.

Listing Versions of an LMS Element

When an element has more than one version, you can display all of its versions in a separate
window. In the list of LMS elements, the number of versions is indicated in the Version Count
column (when a string has not been specified with the Scan for option).

> To list the versions of an LMS element

1  In alist of LMS elements, select an element which has more than one version.

2 Invoke the context menu and choose List.
Or:
Press Fs.

The versions of the selected element are shown in the list view window. Example:

p JICOPY[:NAT:$DC1.IWO.TESTLMS2A] Type=5 List -0 x|

£ Mersion Namel Storage Mu:u:lel Created | Modified D ate I User Date |

[ @ Y 200307-24  2003-07-24 11:35  2003-07-24 11:35
[EIVZANGALT | v 20030829 200308-2915:26 2003-08-29 15:26
ElVZaNGFOOD 20030724 2003-07-2411:32  2002-11-29 08:69

The list contains the following columns:

Column Description

Version Name |Name and number of version.

Storage Mode |Possible values:

D Delta.
\Y% Full version.
Created Creation date of version in format YYYY-MM-DD.

Modified Date (YYYY-MM-DD) and time the version was last modified or renamed.

User Date Date the user specified for the element.
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Submitting an LMS Element Version

You can submit an LMS element version to the operating system.

> To submit an LMS element version

1  Select the appropriate version in an element.

2 Invoke the context menu and choose Submit.
Or:
Press CTRL+S.
A dialog box appears, confirming that the member has been submitted.

Follow mode is automatically activated. When the job has terminated, a corresponding message
is shown.

3 Choose the OK button to close the dialog box.
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In the object workspace, the BS2000 jobs are shown when you expand the Jobs folder of an OSD
node. Example:

=¥ Mainframe Mavigation
F-Em 05390 Nodes
@ YSE Modes
Eﬁ 050 Modes
=[] 194<7500-5115-208
@ 050 Files
=G5 Jobs
@"ﬂj SJL<4850>
I WL AL Y
M 514852

Filtering BS2000 Jobs

Before displaying BS2000 jobs, you can define a filter so that only those jobs are shown which
correspond to your filter criteria.

> To define a filter

1  In the object workspace, select the Jobs folder in the appropriate node.

2  Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:
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J1 MM - Filter Jobs | x|

Node: 222

Job name: ||

TSN [

Originator: |—
|

Dutput device:

~ Type
[T B-Batchjob
[T [ - Dialog task
[T 5 - Spstem task
[~ T-TPtask
[ W - Status waiting
[ H - Status hald
[T K -Status keep

[F Cancel Help
|Enter joh narne.
3  Enter the filter criteria.

Option Description

Job name Job name as specified on the /LOGON or /PRINT command. You can use a combination
of strings and wildcards (* and _) to display the jobs matching the job name pattern.
77

TSN Task sequence number assigned to a specific job. This can be numeric or alphanumeric,

depending on the version of BS2000 installed and the settings of its system parameters.

Originator  |For spoolout jobs, TSN of the task that started the job.

Output device |For spoolout jobs, name of associated output device.

Type Information on job type and status. Possible values:

B - Batch job

Active batch jobs.

D - Dialog task

Active dialog tasks.

S - System task

Active system tasks.

T - TP task

Active TP tasks.

W - Status waiting

Tasks in waiting status.

H - Status hold

Tasks in hold status.

K - Status keep

Tasks in keep status.

4 Choose the OK button.
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Listing BS2000 Jobs

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the B52000 jobs (see Filtering BS2000 Jobs).

~ To list BS2000 jobs

1 In the object workspace, select the Jobs folder in the appropriate node.
2 Invoke the context menu and choose List.
Or:
Press Fs.
A list of jobs is shown in the list view window. Example:
#10b List 194 <7.500-5115-208% -0l =]
£ Job Namel TSH I Typel Calegoryl F'riu:urityl CFPU mm:ss.ccl Devicel Drig-TSNI SizeI Copiesl Uzer ID CFPU usedl CPU max =
WYCHAWGE  B522 1 wT 200 505 10000.00
RYCOMMECT o898 2 BATCH 240 0:07.853 T505 7.89 10000.00
T DAVET 1067 3 DIALOG 240 2242 47 PORTING1 | 136247 32767.00
T DAVET BIE7 3 DIALOG 240 45:17.13 PORTING1 | 271713 32767.00
RYEDTSMF 2254 | 2 BATCH 255 0:01.05 QESMF1 1.09 32767.00
FYFTPSA 8831 2 BATCH 120 023 44 505 2344
RUGAVING 5389 | 3 DI&LOG 240 0027 PORTIMGT 1.27 3276700 —
WYHSMSSERY  BE8S 2 BATCH 240 £:34 51 505 394 51
WYHSMSSERY 8886 2 BATCH 240 £:17.60 505 377 B0
YIS TREAM ez | 2 TF 05 02312 T505 2912
TYMARENCP  BES2 2 TP 2585 1967 SYSMAREW | 19961
TUMAREMUCP 8893 2 TF 240 4:29.58 T505 269,58
TYMEN 5230 3 DIALOG 240 0 04 505 104 32767.00
WYNATSMF1 | 2263 2 BATCH 256 01109 BESMFT 103 32767.00
YMICE, E258 | 3 DI&LOG 240 00114 SMARTS 114 32767.00
TYMICK E2R9 3 DIALOG 240 021 67 SMARTS 2167 32767.00
UMICK 4 5300 | 3 DI&LOG 240 002 SMARTSZ2 112 32767.00
FYMUCTED BIR1 2 BATCH 258 051,10 BESMFT 51.10  32767.00
'—QNUESMH 2282 | 2 BATCH 255 0:0.72 QESMF1 1.72 32?’5?'I.DD '|
4 3
The list contains the following columns:
Column Description
Job Name Job name as specified on the /LOGON or /PRINT command.
TSN Task sequence number assigned to a specificjob. This can be numeric or alphanumeric,
depending on the version of BS2000 installed and the settings of its system parameters.
Type Numeric job identifier. Possible values:
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Column Description
1 Tasks waiting in job pool: WT, HO or
DO(dormant).
2 Active tasks.
3 (Active) dialog tasks.
4 Spoolout jobs waiting to be processed.
5 Active spoolout jobs.
6 RBP spoolout jobs (Remote Batch Processing).
7 RSO spoolout jobs (Remote Spool Output).
8 Active RBP tasks (Remote Batch Processing).
Category Information on the job type and status. Possible values:
BATCH Active batch jobs.
DIALOG Active dialog tasks.
HOLD Tasks in hold status.
KEEP Tasks in keep status.
SYSTEM Active system tasks.
TP Active TP tasks.
WT Tasks in waiting status.
Priority Run priority of job/task.
CPU mm:ss.cc| Amount of CPU time consumed by the job, specified in minutes, seconds and
hundredths of a second.
Device Name of assigned output device (spoolout jobs only).
Orig-TSN Task sequence number of the job that generated the spoolout (spoolout jobs only).
Size Size of spoolout file (spoolout jobs only).
Copies Total number of copies to be printed (spoolout jobs only).
User ID User ID under which the job is executing (usually your own user ID).
CPU used Amount of CPU time consumed by the job, in seconds.
CPU max Maximum amount of CPU time allowed for the job.

Displaying the Condition Codes of a BS2000 Job

You can display the information which is kept in job variables.

~ To display the condition codes of a BS2000 job

1  Select a job in the object workspace or list view window.
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Invoke the context menu and choose Condition Codes.
Or:
Press CTRL+ALT+C.

The list view window appears in the content pane:

§1* TSN=8903 List Job Variables =10 ]|

£ JobWariable [Pathname) IEnntents |
5H13:8T505.5.113.8303.E S5 MAIN. G303 1R F

The list contains the following columns:

Column Description

Job Variable (Pathname) [Full path name including catalog ID and user ID specification.

Contents First 64 bytes of job variable value.

Displaying the Status of a BS2000 Job

You can display the current status of job.

~ To display the status of a BS2000 job

1  Select a job in the object workspace or list view window.
2 Invoke the context menu and choose Status.
Or:
Press CTRL+F10.
The job status is displayed in a dialog box in the content pane. Example:
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CONMECT Status Job x|

@ Job COMMECT{S893) executing: Type 2 BATCH Prio 240 CPU 7,89

3  Choose the OK button to close the dialog box.

Turning on Follow Mode for a BS2000 Job

You can instruct Mainframe Navigation to display a message when the job has terminated.

Follow mode can be active for one job only. If it is activated for a second job before the first job
has terminated, only the second job will be followed.

~ To turn on follow mode for a BS2000 job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Follow.

Turning off Follow Mode for a BS2000 Job

When you turn off follow mode, a message is no longer displayed.

~ To turn off follow mode for a BS2000 job

1  Select ajob in the object workspace or list view window.

2  Invoke the context menu and choose Follow Off.
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Displaying the Output of a BS2000 Job

You can lists the output files which are created by the job and associated by means of a file name
pattern.

Note that site-specific association rules may have been established by your system administrator.
If no such rules apply, the files containing the TSN as part of their name are listed.

~ To display the output of a BS2000 job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Output.

A list of the job's output files is shown in the list view window. Example:

#7: *8904* Lict DSD Files =10 x|
£ File Mame I PAM F'agesl
LE:SR13:4T505.5.113.8904.L1. 5%5LST Q000003
Lﬂ:SFﬂ3:$TSEIS.S.113.8904.LI.5Y5L5T.2 Q000003
Lﬂ:SFH3:$TSEIS.S.113.8904.LI.TSNS Q000003
Lﬂ:SFﬂ3:$TSEIS.S.113.EED4LI.ZWISEHEND.-'1'-.TEI Q000003
L :SR13:47505.5.113.8904 P PROC.1 Q000003
Lﬂ:SFﬂ3:$TSEIS.S.1'I3.8904.F‘.F’HDE.2 Q000003
Lﬂ:SFﬂ3:$TSDS.S.113.8904.F’.F’HDE.3 Q000003
LE#-SR13:$T505.5.L57 8904, 2003-08-23.152005 noooza4
LEd:SR13:4T7505.5.007.8904.2003-08-23,152003 Qoooot 2

The list contains the following columns:

Column Description

File Name |All files which contain the job TSN as part of their name.
PAM Pages |[Number of PAM pages allocated for the file.
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Displaying the Properties of a BS2000 Job

You can display information about a BS2000 job.

~ To display the properties of a BS2000 job

1  Select a job in the object workspace or list view window.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.

A properties dialog box appears.

J1CONNECT Properties Job -0 x|

—Job
Job name: COMMECT TSM: 8833 Type: 2 BATCH
Uzer ID: T505 Pricrity: 240
Account: ADMINSTR Logon date:  2003-03-23 14:48:00
kaw CPU: 1000000 CPU uzed: 709

Unpend/Q#: 17 /4

Command: EXECUTE
Size: 7
Proagran: SR13$TS0S5. 55K SM20MLINE-PC.040[CONMECTOR W04 0410,L)

The following information is shown in this dialog box:

Option Description

Jobname |Job name as specified on the /LOGON or /PRINT command.

User ID User ID under which the job is executing.

Account  |Account number of job for task types 1 - 3.

Max. CPU |Maximum amount of CPU time allowed for the job.

Unpend/Q# |Pend/unpend code for task types 2 and 3.

Command |Last command executed by the task for task types 2 and 3.
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Option Description
Size Size of spoolout file (spoolout jobs only).
Program  |For task types 2 and 3: name of the loaded program.
TSN Task sequence number assigned to the job.
Priority Run priority of job/task.
Type The first value is the numeric job identifier. Possible values:
1 Tasks waiting in job pool: WT, HO or DO(rmant).
2 Active tasks.
3 (Active) dialog tasks.
4 Spoolout jobs waiting to be processed.
5 Active spoolout jobs.
6 RBP spoolout jobs (Remote Batch Processing).
7 RSO spoolout jobs (Remote Spool Output).
8 Active RBP tasks (Remote Batch Processing).
The second value is the category information on job type and status. Possible values:
BATCH Active batch jobs.
DIALOG Active dialog tasks.
HOLD Tasks in hold status.
KEEP Tasks in keep status.
SYSTEM Active system tasks.
TP Active TP tasks.
WT Tasks in waiting status.
Logon date |For task types 2 and 3: date (YYYY-MM-DD) and time of logon.
CPUused |Amount of CPU time consumed by the job, in seconds.

212
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In the object workspace, the BS2000 job variables are shown when you expand the Job Variables
folder of an OSD node. Example:

=¥ Mainframe Mavigation

F-Em 05390 Nodes

@ YW5SE Modes

Eﬁ 050 Modes

=1 B 194¢7.500-5115-208>
@ 050 Files
--1% Jobs
Elﬁ Job Variables
o R SRIZETE0S MOMLY
o R SR1Z4TS0S MON PYS ADA
- SR13:4TS05 MON.PYS CIT

Filtering BS2000 Job Variables

Before displaying BS2000 job variables, you can define a filter so that only those job variables are
shown which correspond to your filter criteria.

> To define a filter

1 In the object workspace, select the Job Variables folder in the appropriate node.

2 Invoke the context menu and choose Filter.
Or:
Press F3.

The following dialog box appears:

#1 MM - Filter Job Yariables

M ode: 222
Job wariable: ||

Pazsword: I

[ Cancel Help

|Enter job variable.

3  Enter the filter criteria.
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Option Description

Job variable |Enter the job variables that are to be shown.

Password |You do not have to enter a password here just to list the job variables.

However, you must enter a password, if you then want to perform read or write operations
on a listed job variable, which requires a password.

To change a job variable, 2 passwords may be required, one for read and and another
one for write. Mainframe Navigation assumes that the entered password is the read
password and prompts for the write password, if required.

For more information on passwords, see Changing the Attributes of a BS2000 Job Variable.

4  Choose the OK button.

Listing BS2000 Job Variables

The number of objects shown in the list view window depends on whether or not a filter has been
defined for the BS2000 job variables (see Filtering BS2000 Job Variables).

> To list BS2000 job variables

1 In the object workspace, select the Job Variables folder in the appropriate node.

2  Invoke the context menu and choose List.
Or:
Press Fs.

The job variables are shown in the list view window. Example:
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#* List Job Yariables -0 x|
£ Job Yanable [Pathname)] -
r'm:SFH ZETS05.@3TS05 KBS KESPARAR

W SR12:4T505.@4T7505. PROC.KBSPARAM

B -SR1Z$T505.ADALIB

W SR13:$T505.ADALIBT

T SR13:$TS05.A5FY

1 -5R12:4$T505.4Y0R. DEO0FTUE. 0001, DESAYE D2 M
21 -SR13:$T505.AY0R. TESTDEEI. 0027 DESAYEDT Hh
W SR13:$T505.COPY

1 SR13:$T505.DATE

B SR1Z$TS0S. DUMMY

1 SR13:$TS05.FT.MON

B -5R13:4$TS05.JB. ARCHIVE KON

W SR13:$T505. 0V ADASAY

1 -SR1Z$T505.0. ADASAY DEO7

B -SR1Z$T505.v.ADASAY. DE205

1 -5R13$T505.0V.ADASAY. DE33

1 :SR13:$T505.0v.ADASAY DES3

1 -SR1Z$T505.0v.ADASAY DEG3

R -cR13 TS5 ANaSay DRRT LI

Adding a New BS2000 Job Variable

You can add a new BS2000 job variable with standard attributes.

~ To add a New BS2000 job variable

—_

In the object workspace, select the Job Variables folder in the appropriate node.

2 Invoke the context menu and choose New.
Or:
Press CTRL+N.

A dialog box appears.

3  Enter the name and the attributes as described in the section Changing the Attributes of a
BS2000 Job Variable.

4  Choose the OK button.
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Changing the Attributes of a BS2000 Job Variable

You can change attributes the attributes of a job variable, for example,

~ To change the attributes of a BS2000 job variable

1  Select a job variable in the object workspace or list view window.

2 Invoke the context menu and choose Change.

The following dialog box appears:

define a password.

#1:5R13:4T505.M0M.1¥ Change Job Yariable 5'
—Job Y ariable
Name: [SR13$TS05 MON.JY
— Security
Shared file; W'z
Arccess type: IWrite vI
R etention period: I
[ Bead passward Hew paszword: I Confirmatian: I
™ wiite pazsword MHew passwond: I Canfirmation: I
— Curent contents
R e e e T e
|$T + P
] | Cancel I Help
|Select shared file.
3 Change the desired attributes.
217
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Option Description
Shared file Yes Makes the job variable accessible to other users.
No Restricts access to the owner user ID.

Access type  |Write Allows write access to the specified job variable,
which also implicitly includes authorization for
read access.

Read Allows read access only.

Retention Enter a number representing a retention period (in days) that is to be assigned to the

period specified job variable: This means it can neither be modified nor deleted within the

specified period of time.

Read Activate this check box to enter or change a password that protects the job variable

password against unauthorized read accesses.

New password Enter new read password in this field.
Confirmation Confirm the new read password in this field.
Write Activate this check box to enter or change a password that protects the job variable
password against unauthorized modification or deletion.
New password Enter new write password in this field.
Confirmation Confirm the new write password in this field.
Current Here you can edit the contents of the job variable.
contents

4  Choose the OK button.

Displaying the Properties of a BS2000 Job Variable

You can display information about a BS2000 job variable.

~ To display the properties of a BS2000 job variable

1  In the object workspace, select the appropriate job variable in the Job Variables folder.

2 Invoke the context menu and choose Properties.
Or:
Press ALT+ENTER.

A properties dialog box appears.

218 Mainframe Navigation



BS2000 Job Variables

#1:5R13:4TS05.ADALIBT Properties Job Yariable

—Job " ariable

=10l x|

Mame: :SR13$TS05.ADALIBY

[ Securiy- Last modification: 2001-01-22
shared fle: - NO Expiration date: ~ 2001-01-22
Access type: WRITE
FRead password: MOME
Wiite pazsword: MOME
— Contents af 10 bytes
S PSR NG TS WSS [ N N D - S S S
ADAT1Z . MOD

The following information is shown in this dialog box:

Option Description
Name Name of the job variable.
Security Shared file YES The job variable is accessible to other users.

NO The job variable is not accessible to other users.

Access type READ Only read access is allowed.

WRITE Read and write access are allowed.

Read password |NONE No password is defined.

YES Read password is defined for job variable. If
the caller is TSOS and Entire System Server is
running under TSOS, the password itself is
returned.

Write password |NONE No password is defined.
YES Write password is defined for job variable. If

the caller is TSOS and Entire System Server is
running under TSOS, the password itself is
returned.

Contents of n
bytes

Displays the content and length of the job variable.
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Option Description

Last Date of last modification in format YYYY-MM-DD.

modification

Expiration The date (YYYY-MM-DD) after which the job variable can be erased.
date

220
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B Browsing the SYSIEM LOG ... ..eviiiiiiii et 224

223



System Log

Each z/OS and z/VSE node in the object workspace contains an entry for the system log (Syslog).
Example:

=] Mainframe Mavigation

g8 05390 Nodes

=-E 148=mrz=
- Datasets
--@ Wolumes
-G Jobs

- Active Jobs

- % Conzole

Browsing the System Log

The system log is shown in a browse window (read-only). You can copy the contents, but you
cannot modify it.

~ To browse the system log

1
2

In the object workspace, select Syslog in the appropriate node.

Invoke the context menu and choose Browse.
Or:

Press CTRL+B.

Or:

Choose the following toolbar button:

5

The system log is shown in a browse window. You are automatically positioned to the most
recent entries at the bottom of the window.

See also Commands for Browsing an Object.
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Console

Each z/OS, z/VSE and BS2000 node in the object workspace contains an entry for the console. Ex-
ample:

-8 Mainframe Marvigation
g5 05390 Nodes
EIE 148=nrz=
--% Datazets
--% Wolumes
- Jobs

-G Active Jobs

= Browsing the Console
= |ssuing an Operator Command

Browsing the Console

The console is shown in a browse window (read-only). You can copy the contents, but you cannot
modify it.

> To browse the console

1  In the object workspace, select Console in the appropriate node.

2 Invoke the context menu and choose Browse.
Or:
Press CTRL+B.

The console is shown in a browse window. You are automatically positioned to the most recent
console messages at the bottom of the window. The window always shows up to 100 lines.

See also Commands for Browsing an Object.
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Issuing an Operator Command

You can issue operator commands to the console.

~ To issue an operator command

1  In the object workspace, select Console in the appropriate node.

2 Invoke the context menu and choose Operate.
Or:

Choose the following toolbar button:

=

The following dialog box appears:

2z MN - 148 Dperate Node [_ [O]
M ode:; 148
Cperator command: || j
[k Cancel Help |

3  Enter an operator command.
4 Choose the OK button.
The dialog box is not closed so that you can enter further operator commands. All operator

commands that you have issued while the dialog box is open can be selected from the drop-
down list box.

5  To close the dialog box, choose the Cancel button.
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